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‘% Wroctaw University
of Science and Technology

WELCOME

to your custom Prospectus of Wroctaw University of Science and Technology (Wroctaw
Tech). It contains information relevant to your interests in future education.

By viewing the individual course pages you will find specific information on courses
available in English as a medium of instruction and admission details you will need,
such as: the programme's duration, the deadline for application and the start date.
You can also find sections on job prospects and courses you will attend during your
studies. We hope you find it both useful and interesting.

Contact details

Wroctaw University of Science and Technology
Admissions Center

Foreign Student Admissions Office
www.pwr.edu.pl

www.admission.pwr.edu.pl

e-mail: admission@pwr.edu.pl

telephone: +48 7132037 11
+48713203170
+48 71 320 44 39

We look forward to seeing you at Wroctaw University of Science and Technology!

Your Admission Officers


http://www.pwr.edu.pl
http://www.admission.pwr.edu.pl
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WROCLAW - A GREAT PLACE TO BE

Woroctaw is the best choice if you are looking for a place
to study. A great atmosphere, a large job market, aca-
demic staff, rich cultural and entertainment offer of the
city that meets students’ needs — all this contributes to
the strength of Wroctaw.

Wroctaw is a city with beautiful architecture and plentiful
green areas situated on the Odra river on 12 islands con-
nected by over 100 bridges. Wroctaw, today the administra-
tive, educational, business and cultural capital of the Lower
Silesia region, is a city with a rich history. The city is situated
close to the borders with Germany and the Czech Republic.

WROCLAW TECH - A GREAT PLACE TO STUDY

Wroctaw University of Science and Technology is one
of the leading scientific and educational centres in Po-
land. Its position among technical universities in the world
strengthens every year. Wroctaw Tech was founded in
1945 but it has over 160 years of intellectual heritage from
Lviv University of Technology and technological heritage
from Technische Hohschule Breslau.

About 21 000 students study at Wroctaw Tech and the num-
ber of academic staff is over 2200. There are students from
over 60 countries and cooperation agreements signed with
more than 120 tertiary institutions from nearly 40 countries.
The university is proud to have a lot of students and staff
exchanges under Erasmus+ Programme, 400 partner uni-
versities, 8 certified laboratories, 540 teaching rooms and
lecture halls, over 1000 didactic and research laboratories.
At the university, there are numerous student organisations

OPPORTUNITIES AND POTENTIAL

Wroctaw has created a favorable ground for diversified
business. It is the largest R&D centre in Poland for global
companies, such as: LG, Philips, Volvo, Bosch, Hewlett-
Packard, Nokia Solutions and Networks, Wabco, KGHM,
Ryanair, Credit Suisse, BNY Mellon, Google, IBM.
Wroctaw Tech ’s Career Office prepare students and gradu-
ates to enter the labour market. It provides students with
job or internship offers, consults CV, supports interesting
projects, organizes meetings with employers, advises in tra-
inings and workshops.

Moreover, Wroctaw Tech has contacts with many
educational and research institutions which facilitates

SCHOLARSHIPS

» Study in Wroctaw www.study-in-wroclaw.pl
» NAWA Scholarship Programmes www.nawa.gov.pl
» Visegrad Scholarship www.visegradfund.org/scholarships

and associations. Students have an opportunity to develop
their scientific and creative passions.

Thanks to Wroctaw Tech the city appears to be the capital
of Polish computer science. This is partly a result of the Euro-
pean standards of teaching and research conducted by the
university employees. The world level of scientific research
and excellent equipment in laboratories lead to cooperation
with many Polish and foreign companies.

All of this allows you to get a degree recognized across
European Union, design your study path and choose
speciality, do simulating and rewarding research on new
technologies such as: nanotechnology, biotechnology,
telecommunications, teleinformatics and information
systems, as well as gain valuable experience and techni-
cal background.

With Wroctaw Tech — nothing is impossible!

pursuing part of your studies outside Poland. Wroctaw
Tech is involved, among others, in the following
projects: Erasmus +, Student Exchange Programmes,
the Double Degree Master Programme T.I.M.E, the
Polish and American Fullbright Commission, DAAD,
Vulcanus in Japan, CEEPUS. Wroctaw University
of Science and Technology is in cooperation with about
200 partners from about 50 countries. All of this can
enhance your future career for sure. Obviously you don’t
have to limit yourself to Wroctaw only, our graduates
can be found all over the world, working for renowned
companies or having set up their own businesses.


http://www.study-in-wroclaw.pl
http://www.nawa.gov.pl
http://www.visegradfund.org/scholarships

TUITION-FREE STUDIES
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Wroctaw Tech does not charge the tuition fees for education at full-time studies from foreigners being citizens of EU / EFTA
countries or having a Polish spouse, as well as from holders of one of following documents:

» Pole’s Card
» Permanent residence or long-term EU-residence card

» Polish Language certificate C1 level www.certyfikatpolski.pl g‘
=

» Refugee status or temporary protection

HOW TO APPLY?

1. GET STARTED

Check out the study offer, required documents and de-

adlines at www.admission.pwr.edu.pl

2. ONLINE REGISTRATION IN THE SYSTEM

» Create an account, fill in all the required data, including
personal data according to your passport, and upload a
formal photo

» Attach documents required for qualification (educatio-
nal documents and language confirmation)

» Sign up for the chosen field of study

» Pay the application fee to the account provided in the
System

3. APPLICATION ASSESSMENT

Wait for the application assessment and check for the

results.

REQUIRED DOCUMENTS

» formal photo (only digital format 300*375 px)

» passport / 1D (only for inspection)

» secondary and higher secondary school certificate/de-
gree certificate with mark-sheets/transcript of records
legalized by the proper embassy or with Apostille

» sworn translation into Polish or English language of
documents issued in any language apart from men-
tioned above (including the legalized certificate mark-
-sheets/other document)

CHECK OPTIONS:
STUDY OPTIONS

Bachelor programmes
duration: 3 — 3,5 years

Master programmes
duration: 1,5 — 2 years

E:I."

HO More information:
www.rekrutacja.pwr.edu.pl

4. TUITION FEE PAYMENT

Pay the tuition fee (if applicable) to the personal bank ac-
count provided in the System.

5. CONDITIONAL ACCEPTANCE

Once the tuition fee payment is received (if applicable),
the Student Status Certificate and Decision of Conditional
Acceptance will be issued.

6. VISA PROCEDURE

Check the list of necessary documents for a student visa
on the Polish Embassy or Consulate website, and schedu-
le an appointment.

7. ARRIVAL and SUBMISSION OF DOCUMENTS
Finalizing the admission process, submit hard copies and
Xerox copies of all required documents in person within
deadlines.

» document confirming the required knowledge of Polish
or English for study purposes - medium of instruction let-
ter / language certificate (at least B2 level IELTS, TOEFL,
etc.) / Skype interview

» medical certificate (only for candidates applying for the
Faculty of Chemistry and Faculty of Geoengineering, Min-
ing and Geology)

» declaration of not holding Polish citizenship

» application form

TUITION FEES

Check out our website:
rekrutacja.pwr.edu.pl/en/for-foreigners/

Doctoral programmes are free of charge and offered at the Doctoral School: https://szd.pwr.edu.pl/en/

Intensive preparatory courses offered to international students who wish to improve their language skills and then to study

in Polish or English:

» English language course (level: B1-B2) 1 year (600 hours)/1 semester (300 hours)
» Summer Polish online course (level: B2) 4 weeks, (80 hours)

» Polish language course (level: A1-B2) 1 year, (600 hours)

To check

the tuition fee
please visit
our website



http://www.certyfikatpolski.pl
https://szd.pwr.edu.pl/en/
https://rekrutacja.pwr.edu.pl/en/for-foreigners/language-courses/
http://www.rekrutacja.pwr.edu.pl
http://www.rekrutacja.pwr.edu.pl
http://rekrutacja.pwr.edu.pl/en/for-foreigners/

APPLIED COMPUTER SCIENCE [l

El DESCRIPTION

The programme emphasises practical aspects of Com-
puter Engineering and can be adapted to the student's
interest. The final effect of studies is obtaining first-
level competencies — knowledge, skills and qualifica-
tions — in accordance with "The Teaching Standards"
in the field of Computer Science. The students acquire

. JOB PROSPECTS

Employment in companies that build, deploy
and maintain IT tools and systems, particular-
ly career in project teams, especially program-
ming teams, in organisations and companies
using software tools and methods, as well as
continuing studies at the Master's level.

the basic knowledge of mathematics and physics, gen-
eral computer science areas, such as: operating sys-
tems, algorithms and data structures, languages and
programming techniques, computer architecture, pro-
ject management, as well as ethical and legal aspects
of computer science. The graduates will be able to: im-
plement and deploy effective, reliable and safe infor-
mation systems that meet users' requirements; com-
prehend, evaluate and deploy different solutions used
in the scope of computer systems; maintain, install,
administrate and deploy tools and problem-oriented
information systems, develop system documentation.

ABOUT STUDIES

» Duration: 7 semesters

» Mode of study: Full time

» Language of instruction: English

» Start date: October 2025 » English:

» Programme coordinator: Equivalent of minimum TOEFL IBT- 87 points
Elzbieta Kukla, PhD or 6.5 points IELTS. List of accepted language

certificates can be checked online.

ENTRY INFORMATION

Requirements: secondary school certificate, re-
ceived after the completion of a recognised sec-
ondary school (total 12 years of education), being
the equivalent of Polish Matriculation certificate.
Each application is assessed individually on its mer-
its. If in doubt, please contact an Admission Officer,
e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology


mailto:admission@pwr.edu.pl
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FACULTY OF INFORMATION AND COMMUNICATION TECHNOLOGY

FIELD OF STUDY: | APPLIED COMPUTER SCIENCE |
BACHELOR'S DEGREE PROGRAMME

CONTENT

The student is required to complete 2475 hours of courses (equivalent to 210 ECTS). The programme consists of lectures
and practical activities: laboratories, tutorials, seminars and projects. Students must receive credits for all subjects and
additionally from applied training. The programme of the internship must be consulted with its coordinator. Instead of
an engineering dissertation, students complete a complex team project. To obtain the professional title of engineer,
students must pass the diploma examination.

SEMESTER 1

» Mathematical Analysis |

» Linear Algebra and Analytic Geometry

» Logic for IT Specialists

» Structural and Object-oriented Programming
» Computer System Organisation

» Physics 1A

SEMESTER 2

» Mathematical Analysis 2

» Discrete Mathematics

Modules of optional courses:

» M2. Web Technologies

» Web Systems Programming

» Developing Web Applications with .NET
» M3. Database Design

» Database Programming

» Database Design

» M4. Mobile Applications

» Mobile Applications for 10S

» Mobile Applications for Android

» Operating Systems SEMESTER 6

» Data Structures and Algorithms o .
» Artificial Intelligence

» Computer Architecture
.p » Business Data Modelling and Analysis
» Physics 2B K
» Internship

» Basic Physics Laboratory Modules of optional courses:

SEMESTER 3 » Basic Physics Laboratory

Theory of Probabilistic and Statistics
7 v » M5. Project Management Basics

: :frfc:egc':\:znrjlrr;i:;ﬁ;i:;echniques » Introduction to IT Project Management
» Support for IT Project Management
? Con'wputer Networks . » M6. Distributed Systems
: f:\zrc:)s":tf:;tlrepreneursh|p » Distributed Computer Systems
» Sport Activi.t'ies » Cloud Programming
» M7. Programming Tools and Technologies

SEMESTER 4 G ;
» Game Programming

» Basics of Software Engineering » Advanced Web Technologies

: SDartia:JiSiS » M8. Multimedia
criptla 8“389_5 o » Computer Graphics
» Systems Analysis and Decision Support » Programming Multimedia Applications
Lectorate 1.2
» Lectorate » Digital Media Processing Technologies

» Sport Activities SEMESTER 7

Modules of optional courses: " .
. . » IT Social and Professional Problems
» M1. Administration of Computer Systems . .
» Team Project Modules of elective courses

» Linux Server Administration .
Modules of optional courses:

» Managing IT Infrastructure .
.g g .. » M9. Current Trends in Computer Science
» Routing and Switching in Computer Networks .
» Data Science

SEMESTER 5 » Neural Networks

» Software Engineerin
g g » Metaheuristics in Problems Solving

» Introduction to loT .
. » Human-Computer Interaction
» Cybersecurity

» Presentation Techniques

Bachelor's Degree programme
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ORGANIZATIONAL MANAGEMENT 8‘)3

El DESCRIPTION

Undergraduate studies in the field of man-
agement (Organizational Management)
allow for a broad understanding of the
principles of the functioning of business or-
ganisations. They provide specialist knowl-
edge necessary to operate in many areas
of the economy. Graduates will develop
their theoretical and practical knowledge
in the field of management sciences and re-
lated sciences, concerning issues, principles
and problems related to the functioning
of the organisation, both at the national
and international level. They will be ready
to take on key project management roles
in both commercial and administrative or-
ganisations. They will be able to commu-
nicate and negotiate effectively, interpret
and use data, and work creatively in teams.

JOB PROSPECTS

The knowledge and skills obtained give the graduates the
possibility of getting a job as a management / organisation
specialist. The management degree (OM) develops compe-
tences useful as a middle-level manager in public and pri-
vate organisations in many sectors (industry, healthcare,
education, services, commerce, central and local authority
institutions, etc.). It provides a way to develop your own
small enterprises or to continue your education at the Mas-
ter's level.

ABOUT STUDIES

» Duration: 6 semesters

» Mode of study: Full time

» Language of instruction: English
» Start date: October 2025

» Programme coordinator:
Maria Hajtasz, PhD

ENTRY INFORMATION

Requirements: secondary school certificate, received
after the completion of a recognised secondary school
(total 12 years of education), being the equivalent of Pol-
ish Matriculation certificate.

Each application is assessed individually on its merits.
If in doubt, please contact an Admission Officer, e-mail:

admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

» English:
Equivalent of minimum TOEFL IBT- 87 points
or 6.5 points IELTS. List of accepted language
certificates can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology



mailto:admission@pwr.edu.pl
mailto:admission@pwr.edu.pl
http://admission.pwr.edu.pl

FACULTY OF MANAGEMENT

FIELD OF STUDY: | MANAGEMENT | ORGANIZATIONAL
MANAGEMENT |BACHELOR'S DEGREE PROGRAMME

CONTENT

» forms of teaching: Lectures, laboratories, tutorials, projects, research

SEMESTER 1

» Civil and Commercial Law
» Essentials of Management
» Information Technology

» Mathematics

» Microeconomics

» Psychology

» Social Philosophy

SEMESTER 2

» Descriptive Statistics

» Essentials of Finance

» Macroeconomics

» Organizational Science

» Sociology

» Work Environment Physics
» Computer Science Module

» Social Competences Module
» Sports

SEMESTER 3

» Mathematical Economics

» Financial Accounting in the Organizational
Decision Making Process

» Marketing in the Information Society

» Organizational Behaviour

» Computer Science Module

» Economic Science Module

» Foreign Language |

» Management of Knowledge

SEMESTER 4

» Contemporary Organizational Methods and
Techniques

» Corporate Finance

» Logistics

» Marketing Management

» Operations Management

» Legal Science Module

» Computer Science Module

» Foreign Language Il

SEMESTER 5

» Diploma Seminar

» Financial Management

» Leading Projects in Modern Organizations

» Marketing Research

» Methods and Tools of Data Analysis

» Modern Human Resource Management

» Total Quality Management

» Computer Science Module

» The Microstructure of the Global Financial Market

SEMESTER 6

» Bachelor's Thesis

» Business Process Management

» Financial Analysis Supported by Computers
» Information Systems in Management

» Introduction to Risk Management

» Sport Activity

» Management Training

» Self-presentation

Bachelor's Degree programme
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MECHANICAL ENGINEERING

= DESCRIPTION . JOB PROSPECTS

The graduate of the Faculty of Mechanical
Engineering is a versatile educated engineer,
equipped with basic and advanced knowledge
as well as industrial practice.

This programme prepares the graduates for creative engi-
neering work in machine design, machine operation and
manufacturing processes. The student will be familiar
with fundamental methods, techniques, tools and materi-
als used for solving engineering tasks in the field of Me-
chanical Engineering. The student acquires a directional
specialty by studying mechanics, machines theory, princi-
ples of machine design, thermodynamics, computer-aided
engineering techniques and manufacturing technologies.
The programme gives reliable grounds to take a job in any
segment of industry and services where designing, pro-
ducing or maintaining machines and equipment is essen-
tial for a business.

ENTRY INFORMATION

Requirements: secondary school certificate, re-
ceived after the completion of a recognised sec-
ondary school (total 12 years of education), being
the equivalent of Polish Matriculation certificate.
Each application is assessed individually on its
merits. If in doubt, please contact an Admis-
sion Officer, e-mail: admission@pwr.edu.pl

ABOUT STUDIES » Deadline for application

» Tuition fee
» Duration: 7 semesters » Application fee

» Mode of study: Full time

» Faculty of: Mechanical Engineering

» Language of instruction: English »  English: Equivalent of minimum TOEFL IBT
» Start date: October 2025 — 87 points or 6.5 points IELTS. List of
» Programme coordinator: accepted language certificates can be

Stawomir Susz, PhD checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF MECHANICAL ENGINEERING

FIELD OF STUDY: | MECHANICAL ENGINEERING | MECHANICAL
ENGINEERING | BACHELOR'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 SEMESTER 4

» Engineering Graphics: Descriptive Geometry » Fundamentals of Machine Design |

» Chemistry » Theory of Mechanisms and Manipulators
» Information Technologies » Chipless Processes -Plastic Forming

» Fundamentals of Metrology » Chipless Processes -Welding Metallurgy
» Ergonomy and Safety » Geometric Metrology

» Linear Algebra with Analytic Geometry B » Drive Systems

» Mathematical Analysis 1A » Strength of Materials

» Physics » Industrial Metrology

SEMESTER 2 SEMESTER 5

» Engineering Graphics: Engineering Drawing
» Engineering Materials Technology
» Elements of Mathematical Analysis
» Thermodynamics

» Fundamentals of Materials Science
» Mechanics |

» Ecology

» Theory of Machines

» Essential of Management

» Electrical Engineering

» Electronics

» Hydraulic, Hydrotronic
and Pneumatic Systems
» Finite Elements Method
» Fundamentals of Machine Design Il
» Fundamentals of Automatic Control
» Manufacturing Processes - Machining
» Vehicle Engineering
» Trybology
» Computer Aided Machine Design |

SEMESTER 6
SEMESTER 3 » Safety of Machines
» Engineering Graphics 3D and Technological Processes
» Electrical Engineering » Manufacturing Systems CNC
» Statistics for Engineers » Offroad Vehicles Engineering
» Fluid Mechanics » Hydraulic Drive Systems
» Materials Science » Internal Combustion Engines
» Mechanics Il » Carrying Structures
» Polymers | » Computer Aided Machine Design Il
» Chipless Processes -Casting
» Fundamentals of Materials Strength SEMESTER 7

» Programming in MATLAB

Fundamentals of Exploitation
» Ordinary Differential Equations 7 P

and Repair
» Management in production
» Production System Organisation
» Thesis, Seminar
» Polymers in Engineering
» Vehicles Loading Modelling
» Legal Aspects of Engineering Activities

Bachelor's Degree programme


mailto:admission@pwr.edu.pl

MEDICAL INFORMATICS

. JOB PROSPECTS

El DESCRIPTION

There is a growing demand for biomedical engineers
with interdisciplinary knowledge of medicine, computer
science, and medical devices. Such a background is indis-
pensable to meet the demands of the rapidly changing
healthcare system, which strives to accommodate the
needs of patients and healthcare personnel.

This specialty is addressed to inquisitive students inter-
ested in biomedical applications of artificial intelligence, big
data, mobile and wearable devices, augmented and virtual
reality. We encourage students to carry out their research
projects or join one of several students’ science clubs.
Medical Informatics (Ml) focuses on technologies, impact-
ing patient-doctor relationship by effectively collecting,
securing and understanding health data, thereby sup-
porting medical diagnosis and treatment. The courses in
this study program are oriented towards these practical
aspects of Ml.

Graduates can work for:

e |T companies

e Hospitals and healthcare units
e medical device companies

e  R&D companies

ABOUT STUDIES

» Duration: 7 semesters

» Mode of study: Full time

» Language of instruction: English
» Start date: October 2025

» Programme coordinators:
Prof. Mirostaw tatka,
Department of Biomedical Engineering

ENTRY INFORMATION

Requirements: secondary school certificate, re-
ceived after the completion of a recognised sec-
ondary school (total 12 years of education), being
the equivalent of Polish Matriculation certificate.
Each application is assessed individually on its
merits. If in doubt, please contact an Admission
Officer, e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

»  English:
Equivalent of minimum TOEFL IBT— 87
points or 6.5 points IELTS. List of accepted
language certificates can be checked
online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology



mailto:admission@pwr.edu.pl
mailto:admission@pwr.edu.pl
http://admission.pwr.edu.pl

FACULTY OF FUNDAMENTAL PROBLEMS OF TECHNOLOGY

FIELD OF STUDY: | MEDICAL INFORMATICS | MEDICAL INFORMATICS |
BACHELOR'S DEGREE PROGRAMME

CONTENT

OBLIGATORY COURSES

IT COURSES

» Databases

» Introduction to Object-Oriented Programming
» Introduction to Programming

» Mobile Application Development

» Modelling of Biological Systems

» Network Technologies

» Numerical Methods

» Programming in Python

» Software Engineering

GENERAL COURSES

» Academic Writing

» Algebra and Analytic Geometry

» Anatomy for Biomedical Engineers

» Introduction to Biomedical Optics and
Biophotonics

» Biochemistry

» Biophysics

» Mathematical Analysis

» Medical Imaging Techniques

» Legal and Ethical Aspects in Biomedical
Engineering

» Physics

» Principles of Chemistry

» Principles of Organic Chemistry

» Propaedeutics of Medical Sciences
» Statistics and Probability Theory

ENGINEERING COURSES

» Conversion and Analysis of Non-electrical Signals
» Digital Signal Processing

» Electromedical Instrumentation

» Introduction to Medical Electronics

» Measurement systems

» Microcontrollers

OPTIONAL COURSES

» Advanced Imaging Techniques

» Artificial Intelligence

» Complex Systems

» Computer Graphics

» Computer Science in Medicine

» Elements of Nonlinear Dynamics

» Introduction to Bioinformatics

» Statistical Methods in Bioengineering
» Time Series Analysis

Bachelor's Degree programme



mailto:admission@pwr.edu.pl

ELECTRONIC

AND COMPUTER ENGINEERING

El DESCRIPTION ENTRY INFORMATION
Imagine a world where technology surrounds you at eve- Requirements: secondary school certificate,
ry step — from smart devices in your home to advanced received after the completion of a recognised
robots in industry. The EAC programme is your gateway secondary school (12 years of education in to-
to this exciting reality! We combine expertise in electron- tal), being the equivalent of Polish Matriculation
ics, programming, machine learning, and robotics, pre- certificate.
paring you to work with technologies shaping the future. Each application is assessed individually on its
Discover the secrets of the Internet of Everything and merits. If in doubt, please contact an Admission
gain skills that open the door to an extraordinary career. Officer, e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee

JOB PROSPECTS » Application fee

Studying at EAC equips you with the knowledge and
skills to land a job right after graduation. Our gradu-
ates are in high demand, especially in industries fo-
cused on designing, producing, and maintaining elec-
tronic systems, as well as software development. The
need for specialists who can integrate analog and
digital systems, including microprocessors, is rapidly
growing. You'll gain expertise in: programming, Al
algorithm implementation, designing advanced elec-

tronic and robotic systems. With the rise of loT com- ABOUT STUDIES
panies and smart home technologies, engineers who

blend electronics and computer science knowledge
are more valuable than ever. From design to produc-
tion and beyond — EAC prepares you for every stage
of this cutting-edge industry. » Language of instruction: English

» Start date: October 2025

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS.
List of accepted language certificates
can be checked online.

» Duration: 7 semesters

» Mode of study: Full time

» Programme coordinator:
Grzegorz Budzyn, PhD

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF ELECTRONICS, PHOTONICS AND MICROSYSTEMS

FIELD OF STUDY: | ELECTRONIC AND COMPUTER ENGINEERING |
BACHELOR'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 SEMESTER 5

» Mathematics Analysis 1 » Computer Networks

» Mathematical Algebra » Microcontrollers

» Introduction to Programming » Elective courses (choice of 3 out of 5:

» Metrology Advanced Topics in Robotics, Digital Signal

» Philosophy Processing, Artificial Intelligence & Computer

Vision, Optoelectronics, Wireless Systems)

SEMESTER 2

» Mathematics Analysis 2 SEMESTER 6

» Mathematics for Electronics » Selected Topics in Deep Learning

» Object Oriented Programming » Edge Al

» Electronics 1 » Team and Pre-engineering Project

» Physics » Elective courses (choice of 3 out of 6: Control

» Foreign Language Systems Engineering, Embedded Systems,
Real-Time Operating Systems, Lasers,

SEMESTER 3 Fibers and Applications, Cybersecurity,

. Electroacoustics)
» Electronic Components

» Electronics 2

» Electronic Technology SEMESTER 7
» Scientific and Engineering Programming » Internship
» Python » Final Project
» Math for Electronics » Diploma Seminar
» Entrepreneurship
» Copyright
SEMESTER 4 Pyne . _
» Elective courses (choice of 2 out of 5:
» Sensors

Electrotechnics, Medical Electronics,
Electronics for Renewable Energy Sources,
Machine Learning, Ultrasonic Technology)

» Electronic Circuits

» Software Engineering

» Fundamentals of Telecommunications

» Introduction to Logic and Microcontrollers
» Introduction to Automation

» Introduction to Robotics

Bachelor's Degree programme
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ARCHITECTURE

= DESCRIPTION

The study programme takes into account
in a balanced way the practical and theoreti-
cal aspects of the architectural profession
with an emphasis on the problem of creativ-
ity and design independence of graduates.
The leading courses in the students' educa-
tion are design, which is complemented by
field studies related to modern construction
systems, as well as theoretical (theory of ar-
chitecture and urban planning, heritage pro-
tection, elements of philosophy, aesthetics)
and computer-based (various types of mod-
elling: BiM, 3D) ones. All offered courses and
design studies are based on the "Research
by design" model, and their wide choice al-
lows students to pursue individual creative
interests. Students have the opportunity
to work with active architects, with spe-
cialists in various fields, and they can also
participate in scientific programmes, inter-
national exchanges, workshops and study
trips.

After completion of the Master’s pro-
gramme in Architecture and Urban Planning
students are awarded the Master’s Degree
in Architecture. Graduates are equipped
with knowledge and skills that enable them
to enrol themselves on doctoral and special-
ised postgraduate programmes.

JOB PROSPECTS

In the Architecture and Urban Planning Master's
programme, we train specialists who are able to
think critically and independently, who are ready
to implement innovative architectural solutions
and who are professionally flexible with a wide
range of possibilities to choose their professional
path. Learning outcomes provide preparation
of graduates to work in: architectural and town
planning offices, public administration units relat-
ed to architecture and urban planning. Due to the
broad, interdisciplinary profile of the education,
graduates can also undertake research-related
work and continue their studies at the Doctoral
School. Moreover, graduates have skills related
to IT techniques, which are necessary both in the
work of a designer and a manager planning the in-
vestment process. They are able to work in a team,
they are aware of the social role of the architec-
tural profession and the humanistic aspects of en-
gineering activity.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
»  Start date: October 2025

ENTRY INFORMATION

Requirements: Architect Engineer. Portfolio.
Minimum 210 ECTS. Each application is assessed
individually on its merits.

If in doubt, please contact an Admission Officer,
e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

»  English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS.
List of accepted language certificates
can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF ARCHITECTURE

FIELD OF STUDY: | ARCHITECTURE | ARCHITECTURE |
MASTER'S DEGREE PROGRAMME

SEMESTER1

» Architectural Design (elective)

» Urban Design (elective)

» Conservation and Special Design (elective)

» Protection of Cultural Heritage (elective)

» Theory and History of Architecture

» Theory and History of Urban Planning
(20c.—21c.)

» Structures in Contemporary Architecture

» Computer Aided Design BIM

» Foreign Languages (elective)

» An Introduction to Mathematical Modelling

SEMESTER 2

» Architectural Design (elective, including
Studios)

» Design Workshop — Integration of Design
Processes

» Ecology (elective)

» Physics (acoustics)

» Humanities (elective)

» Sociology and environmental psychology
(elective)

» Foreign Languages (elective)

» Metology of Scientific Work

» Structures in Contemporary Architecture

» Modern Technologies

» Ergonomics

» Professional Ethics and Law

SEMESTER 3

» Diploma thesis

» Design workshops 2x (elective)

» Architecture and Urban Planning — Repertory
» Spatial Planning

THE AUTHOR: JULIA JANISZYN: MASTER DIPLOMA 2020/21, ,SENSUM — THE MUSEUM OF SENSES IN WROCLAW”

Master's Degree programme
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CIVIL ENGINEERING

DESCRIPTION

The students gain theoretical knowledge
and practical skills connected with structure
design, construction materials and technol-
ogiesaswellasstaticand dynamicanalysis of
reinforced concrete, prestressed concrete,
metal, wooden, ground and complex con-
structions. They learn how to use advanced
computational models and modern IT
solutions in civil engineering. In addition
to participating in lectures, presentations,
labs, seminars and projects the students
may also take part in the student scien-
tific groups and international exchanges.
A number of courses can be selected by the
students depending on their interests and
professional plans. At the end of the MSc
study students write master's thesis on a sub-
ject related to designing of engineering struc-
tures. The MSc diploma offers an opportunity
to continue education at PhD studies.

. JOB PROSPECTS

The graduates are prepared for:

» solving complex design, organisation or
technological problems,

» authorisation to independent design and
construction in civil engineering,

» developing and implementing research programmes,

» carrying out jobs in international enterprises,

» participation in marketing and promotion of
construction products,

» continuing education, participation in research
in the fields directly related to construction and
construction production,

» continuous education, improving qualifications and
extending knowledge,

» team work and large team management.

The graduates are prepared to work in design offices
and construction enterprises, scientific institutions
and R&D centres, institutions involved in building in-
frastructure management or dealing with counselling
or dissemination of construction-related knowledge.

ABOUT STUDIES

» Duration: 3 semesters
»  Mode of study: Full time
» Language of instruction: English

» Start date:
October 2025 or February 2026

» Programme coordinator:
Prof. Jan Bien, PhD, DSc

ENTRY INFORMATION

Requirements: Bachelor's or Master's Degree in Civil
Engineering, Environmental Engineering, Architecture,
Hydrotechnical Engineering obtained either in Poland
or abroad.

Each application is assessed individually on its merits.
If in doubt, please contact an Admission Officer, e-mail:
admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

»  English: Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of accepted
language certificates can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF CIVIL ENGINEERING

FIELD OF STUDY: | CIVIL ENGINEERING | CIVIL ENGINEERING |
MASTER'S DEGREE PROGRAMME

CONTENT

The main study of Civil Engineering consists of obligatory and elective courses, covered as lectures, projects and
seminars. In addition, some elective units are offered covering also language courses.

SEMESTER1

» Advanced Computer Aided Engineering
» Concrete Structures - Objects

» Metal Structures - Objects

» Selected Topics in Structural Mechanics
» Theory of Elasticity and Plasticity

» Physics of Modern Materials

» Selected Topics in Mathematics

» Selected Topics in Geoengineering — Foundation
» Hydraulics in Civil Engineering

» Ethics in Engineering/Ethics in Business
» Foreign Language 1

» BIM in Civil Engineering

SEMESTER 2

» Dynamics

» Underground Structures — Urban Infrastructure
» Railways

» Roads, Streets and Airports

» Bridges

» Construction Techniques and Processes

» Apartment Building

» Computational Mechanics

» Foreign Language 2

SEMESTER 3

» Master's Thesis Seminar
» Master's Thesis
» Construction Project Management
- 2 elective courses (one from each group)

ELECTIVE COURSES 1

» Artificial Intelligence in Civil Engineering

» Modern Testing Methods for Non-destructive
Inspection of Building Structures

» Advanced Building Physics

» Hydrology for Building Engineers

» Effective Properties of Composites
— Introduction to Micro-mechanics

ELECTIVE COURSES 2

» Pre-stressed Concrete Structures

» Timber Structures

» Conservation and Strengthening of Monumental
Heritage Structures

» Methods of Applied Statistics (Geostatistics)

» Sustainable Building

Master's Degree programme
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ADVANCED NANO
AND BIOMATERIALS MONABIPHOT

Asd.

El DESCRIPTION

Advanced Nano and Biomaterials MONABIPHOT
is a Master's course which offers an original qualifica-
tion in the highly innovative domain of nanomaterials
and molecular photonics for materials science and
biology. Skills will be acquired at the strongly interdis-
ciplinary level needed to master emerging technolo-
gies and to develop original concepts and applications,
aiming at novel technological breakthroughs in this
domain. We offer courses concerning synthesis and
characterization of new materials on the molecular
and nanoscale with the special impact on biology. The
introduction of the course's subjects help the student
to acquire competences as future experts in ma-
terial science, with special impact on nanomaterials.
The language of the Advanced Nano and Biomaterials
MONABIPHOT Master's is English. Applicants must
have a Bachelor’s degree in Chemistry, Physics or Ma-
terials Science or related subjects, with a good back-
ground in mathematics and chemistry. The graduates
could continue the career in research in nano- and/
or bio-materials, as Ph.D. students or R&D associ-
ates in industrial laboratories in the rapidly emerging
nanotechnology industry.

The programme is aimed at students already awarded
or expecting a BSc (or a higher degree) or equivalent
before the starting date of the term (September 2025
for the current applications).

. JOB PROSPECTS

The graduate has extended knowledge
of chemistry, materials science, natural
sciences and technical skills: conduct
advanced research experiments with
the nanomaterials with the emphasis
on biology, propose and optimize new
solutions and independently analyze
problems related to materials science.
The graduates are prepared for crea-
tive work in the design and operation
ofnewmaterials.Thegraduateisprepared
to run the own business.

ABOUT STUDIES

» Duration: 3 or 4 semesters
»  Mode of study: Full time
» Language of instruction: English

» Start date:
October 2025 - 4 semesters for candidates without
engineering degree

» February 2026 - 3 semesters

» Programme coordinator:
Katarzyna Matczyszyn, PhD, DSc, Prof. at Wroctaw Tech

ENTRY INFORMATION

Requirements: Bachelor's or Bachelor
of Engineering Degree in Materials Sci-
ence, Chemistry or related domains.

Each application is assessed individually
on its merits. If in doubt, please contact
an Admission Officer, e-mail: admission@
pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

»  English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of
accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF CHEMISTRY
FIELD OF STUDY: | ADVANCED NANO AND BIOMATERIALS MONABIPHOT]|
| ADVANCED NANO AND BIOMATERIALS MONABIPHOT |
MASTER'S DEGREE PROGRAMME

CONTENT

21

The main study of Advanced Nano- and Bio-materials MONABIPHOT consists of at least 23 units, covered as

lectures, labs and seminars. In addition, some optional units are offered covering also language courses.

SEMESTER O

» Informatics for Engineers

» Biotechnology with introduction to industrial
microbiology

» Basics of Technical Drawing

» Technical Safety in Industry

» Material Recovery and Recycling

» Fundamentals of Chemical and Process
Engineering

» Bioreactors

» Introduction to Materials Science and
Engineering

» Fundamentals of Chemical Technology Design

» Separation and Purification of Products

SEMESTER1

» Liquid Crystals for Photonics

» Modern Polymers

» Modern Spectroscopy

» Bioorganic Chemistry

» Fluorescence Spectroscopy and Bioimaging

» Biophotonics

» Mathematical Methods in Planning and
Analysis of Experiment

» Graduation proseminar

» Managerial course

» Foreign Language |

» Foreign Language I

SEMESTER 2

» Laser and Microscopic Techniques in Materials
Analysis

» Nonlinear Optics for Chemists

» Nanoscale Physics

» Advanced Functional Materials

» Nanomaterials

» Organic Electronics

» Advanced Research Methods in the Engineering of

Materials
» Optional course
» Graduate Laboratory |

SEMESTER 3

» Advanced Functional Materials
» Optional course

» Graduate Laboratory Il

» Graduation Seminar

OPTIONAL COURSES

» Biomaterials

» Nonlinear Optics for Chemists
» Metallic Materials

» Basics Molecular Dynamics

Master's Degree programme



mailto:admission@pwr.edu.pl

BIOINFORMATICS

DESCRIPTION

Field of study:

BIOSCIENCES

The BioSciences major offers a rigorous
exposure to the modern experimental
and computational disciplines within
Bioinformatics and Medicinal Chemistry
fields. The curriculum includes upper-
level coursework in chemistry, physics,
applied informatics, or bioinformatics
allowing students to deepen their under-
standing of the intricate world of (nano)
bio-oriented chemistry. Students have
the opportunity to experience cutting-
edge modern research within the faculty.
Our curriculum is designed to provide
students with a broad and well-rounded
education that will enable them to pur-
sue a career in academia and pharmaceu-
tical or IT industry.

Speciality:

Bioinformatics

Bioinformatics constitutes an interdisci-
plinary research area, covering applica-
tions of computer science, chemistry and
biochemistry to solve biological prob-
lems, usually at the molecular level.
Typical activities include analysis of infor-
mation contained in literature, genetic
and structural databases, prediction of
protein structure, drug and biocatalyst
or biosensor design. The curriculum in-
troduces programming skills necessary
for automation of database searches and
analysis of numerical and bioinformatics
data, including analysis of new genome
sequencing (NGS) results. The study pro-
gramme includes advanced computer
programming as well as specialized mo-
lecular biology techniques which are
highly valued on present job market.

ABOUT STUDIES

» Duration: 3 or 4 semesters

»  Mode of study: Full time

» Language of instruction: English

»  Start date: October 2025 - 4 semesters for
candidates without engineering degree
February 2026 - 3 semesters

» Programme coordinators:
M Prof. Tadeusz Andruniow, PhD, DSc

JOB PROSPECTS

The combination of computational skills and basic
knowledge of biotechnology aims to prepare the graduates
for work in research and development sectors, manufactur-
ing chemical software or databases, developing modern
bioinformatics diagnostic services in medical laboratories,
conducting quality control in environment protection phar-
maceutical or food industry laboratories. Our graduates
typically continue level Il (Ph.D.) education in renowned
academic institutions or are employed by national and in-
ternational companies.

i3l  ENTRY INFORMATION

Requirements: Bachelor's or Bachelor of Engineering De-
gree in Chemistry or related domains (3-semester pro-
gramme). Each application is assessed individually on its
merits. If in doubt, please contact an Admission Officer,
e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of accepted
language certificates can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF CHEMISTRY

FIELD OF STUDY: | BIOSCIENCES | BIOINFORMATICS |
MASTER'S DEGREE PROGRAMME

CONTENT

The curriculum is composed of at least 25 units, covered as lectures, labs or seminars.

SEMESTER O

» Informatics for Engineers

» Biotechnology with Introduction to Industrial
Microbiology

» Basics of Technical Drawing

» Technical Safety in Industry

» Material Recovery and Recycling

» Fundamentals of Chemical and Process
Engineering

» Bioreactors

» Introduction to Materials Science and
Engineering

» Fundamentals of Chemical Technology Design

» Separation and Purification of Products

SEMESTER 1

» Bioinformatics

» Molecular Dynamics

» Networks and Workstations with UNIX System
» Applied Informatics

» Theoretical Chemistry

» Graduation Proseminar

» Managerial Course |

» Foreign Language |

» Elective course

SEMESTER 2

» Molecular Modeling

» Bionanotechnology

» Rational Drug Design

» Advanced Bioinformatics

» Advanced Programming and Numerical
Methods

» Data Mining

» Retrieval of Scientific and Technical Information

» Managerial Course Il

» Graduate Laboratory |

» Foreign Language Il

SEMESTER 3

» Machine Learning for Chemistry and Biology
» Computational Genomics

» Molecular Engineering in Genomic Analyses
» Graduate Laboratory Il

» Graduation Seminar

ELECTIVE COURSES

» Medicinal and Biological Chemistry

» Methodology of Experimental Research

» Bioprocess Project

» Advanced Polymers for Chemical and Medical
Applications

Master's Degree programme
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MEDICINAL CHEMISTRY &

El DESCRIPTION

Field of study:

BIOSCIENCES

The BioSciences major offers a rigorous expo-
sure to the modern experimental and computa-
tional disciplines within Bioinformatics and Me-
dicinal Chemistry fields. The curriculum includes
upper-level coursework in chemistry, physics,
applied informatics, or bioinformatics allowing
students to deepen their understanding of the
intricate world of (nano)bio-oriented chemis-
try. Students have the opportunity to experi-
ence cutting-edge modern research within the
faculty. Our curriculum is designed to provide
students with a broad and well-rounded educa-
tion that will enable them to pursue a career in
academia and pharmaceutical or IT industry.
Speciality:

Medicinal Chemistry

Medicinal chemistry is a scientific discipline at
the intersection of chemistry and computational
science, connected with designing, synthesiz-
ing and developing new pharmaceuticals. At the
beginning, medicinal chemistry was involved in
screening of natural sources like plants or animals
for bioactive compounds. Now, natural products
serve as the lead structures in the synthesis and
development of new chemical entities dedi-
cated for therapeutic use. Medicinal chemistry
includes preparation and analysis of existing and
new potential drugs, evaluation of their biologi-
cal properties, analysis of structure-activity rela-
tionships. It is a highly interdisciplinary discipline
widely using advanced, synthetic, spectroscopic,
computational methods and machine learning.
Thus, medicinal chemists cooperate with theo-
retical chemists, synthetic chemists, medical
doctors, microbiologists and pharmacologists.
The graduation document certifies the degree
in chemistry with the notification of a deepened
specialization in Medicinal Chemistry. The study
for applicants without engineering degree lasts
2 years, otherwise 1.5 years only.

ABOUT STUDIES

» Duration: 3 or 4 semesters

»  Mode of study: Full time

» Language of instruction: English

» Start date: October 2025 - 4 semesters for
candidates without engineering degree
February 2026 - 3 semesters

» Programme coordinators:
& Prof. Rafat Latajka, PhD, DSc

JOB PROSPECTS

The students are educated in the field of chemistry, mainly
synthesis, structure analysis including spectroscopic meth-
ods, molecular modeling, machine learning and they have
training in medicinal chemistry. Some students, depending
on their Master thesis topic, may accomplish part of their

research and/or graduate laboratory at Medical University,
under supervision of medical doctors or in the Institute of Im-
munology and Experimental Therapy in Wroctaw. Master's
Degree programmes provide many skills and abilities de-
manded in scientific laboratories as well as in modern chemi-
cal and pharmaceutical industry, especially in R&D units.

ENTRY INFORMATION

Requirements: Bachelor's or Bachelor of Engineering De-
gree in Chemistry or related domains (3-semester pro-
gramme). Each application is assessed individually on its
merits. If in doubt, please contact an Admission Officer,
e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of accepted
language certificates can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +4871320 3711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF CHEMISTRY

FIELD OF STUDY: | BIOSCIENCES | MEDICINAL CHEMISTRY |
MASTER'S DEGREE PROGRAMME

CONTENT

The main study of Medicinal Chemistry consists of at least 22 units, covered as lectures, labs
and seminars. In addition some optional units are offered covering also language courses.

SEMESTER O

» Informatics for Engineers

» Biotechnology with Introduction to Industrial
Microbiology

» Basics of Technical Drawing

» Technical Safety in Industry

» Material Recovery and Recycling

» Fundamentals of Chemical and Process
Engineering

» Bioreactors

» Introduction to Materials Science and
Engineering

» Fundamentals of Chemical Technology Design

» Separation and Purification of Products

SEMESTER 1

» Theoretical Chemistry

» Spectroscopic Methods in Medicinal Chemistry

» Crystallography and Structure of Solids

» Analytical Methods in Drug Design and
Technology

» Introductory Statistics

» Isolation and Identification of Bioproducts

» Metabolomics

» Managerial Course |

» Foreign Language |

» Graduation Proseminar
» Elective course

SEMESTER 2

» Metabolomics

» Molecular Modeling

» Retrieval of Scientific and Technical Information

» Medicinal Natural Products

» Modern Pharmaceuticals and
Biopharmaceuticals

» Rational Drug Design

» Managerial Course Il

» Foreign Language I

» Graduate Laboratory |

SEMESTER 3

» Multistep Organic Synthesis

» Inorganic Drugs

» Machine Learning for Chemistry and Biology
» Graduate Laboratory Il

» Graduation Seminar

ELECTIVE COURSES

» Medicinal and Biological Chemistry

» Methodology of Experimental Research

» Bioprocess Project

» Advanced Polymers for Chemical and Medical
Applications

Master's Degree programme
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ADVANCED CHEMICAL TECHNOLOGY

(o)
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El DESCRIPTION

Field of study:

CHEMICALENGINEERING AND TECHNOLOGY
The Master of Chemical Engineering and Tech-
nology Program aims to provide students with
advanced knowledge, practical skills, and inno-
vative thinking in the field of chemical engineer-
ing and technology to solve complex industrial
challenges. The program will focus on cutting-
edge technologies, emphasizing the practical
application of engineering principles in solving
the problems of modern society. Graduates will
be well-prepared to take on leadership posi-
tions in the industry or pursue further studies at
the PhD level.Speciality:

Advanced Chemical Technology

Advanced Chemical Technology aims to provide
students with advanced knowledge and practi-
cal skills in the field of chemical technology. The
program emphasizes the practical application
of technology principles to address complex in-
dustrial and societal problems, preparing gradu-
ates for careers in the industry as well as engag-
ing them with the latest research in the field.
The program will consist of core and elective
courses in the following areas:

- Advanced chemical process design and optimi-
zation

- Chemical reaction engineering

- Separation processes

- Bioprocess engineering

- Surface chemistry

- Materials science and engineering

- Product design and development

- Environmental engineering and sustainability
- Industrial plant design, modelling and simulation.
In addition to coursework, students will under-
take a research team project and graduate the-
sis in a specialized area of chemical technology.
The research project and thesis requirement
will allow students to gain hands-on expertise in
applying theoretical and practical methodolo-
gies to real-world challenges in the field.

ABOUT STUDIES

» Duration: 3 or 4 semesters
»  Mode of study: Full time
» Language of instruction: English

»  Start date: October 2025 - 4 semesters for
candidates without engineering degree
February 2026 - 3 semesters

» Programme coordinator:
Piotr Rutkowski, PhD DSc, Prof. at Wroctaw Tech

JOB PROSPECTS

Graduates of the program will be equipped with advanced
knowledge, practical skills, and innovation thinking in chemi-
cal technology, and be well-prepared for careers in industrial
manufacturing,research and development, and technology
consulting firms. Potential career paths include chemical
technologist, product development engineer, process engi-
neer, environmental engineer, research scientist, and quality
assurance specialist. Graduates will be able to work within
diverse industries, including pharmaceuticals, biorefineries,
chemicals, energy and fuels, and materials science.

ENTRY INFORMATION

Requirements: Bachelor's or Bachelor of Engineering De-
gree in Chemical Engineering or related domains (3-se-
mester programme). Each application is assessed individ-
ually on its merits. If in doubt, please contact an Admission
Officer, e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of accepted
language certificates can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF CHEMISTRY

FIELD OF STUDY: | CHEMICAL ENGINEERING AND TECHNOLOGY 27/
| ADVANCED CHEMICAL TECHNOLOGY | MASTER'S DEGREE PROGRAMME

CONTENT

The main study of Advanced Chemical Technology consists of at least 23 units, covered as lectures, labs and
seminars. In addition, some optional units are offered covering also language courses.

SEMESTER O

» Informatics for Engineers

» Biotechnology with Introduction to Industrial
Microbiology

» Basics of Technical Drawing

» Technical Safety in Industry

» Material Recovery and Recycling

» Fundamentals of Chemical and Process
Engineering

» Bioreactors

» Introduction to Materials Science and Engineering

» Fundamentals of Chemical Technology Design

» Separation and Purification of Products

SEMESTER 1

» Advanced Chemical Technologies — Biorefinery
Technologies for Chemicals and Fuels

» Industrial Plants Design Principles

» Environmental Protection in Chemical Industry

» Trends in Chemical Engineering and Technology

» Surface Phenomena and Heterogenous Catalysis

» Retrieval of Scientific and Technological Resources

» Mathematics for Engineers

» Managerial Course |

» Managerial Course Il
» Foreign Language |
» Graduation Proseminar

SEMESTER 2

» Advanced Chemical Technologies — Modern
Macromolecular Engineering Materials

» Chemical Sensors and Biosensors — Fundamentals
and Applications

» Chemical Reactors and Bioreactors

» Green Chemistry and Sustainable Technology

» Scientific Team Project

» Foreign Language Il

» Graduate Laboratory |

SEMESTER 3

» Advanced Chemical Technologies —
Nanotechnologies and Energy

» Elective course

» Graduate Laboratory Il

» Graduation Seminar

. CONCLUSION

The Master of Advanced Chemical Technology Pro-
gram will provide students with advanced knowl-
edge, practical skills, and innovation thinking in the
field of chemical technology. The program's cur-
riculum and research requirements have been tai-
lored to equip graduates with a thorough ground-
ing in theoretical and practical aspects of chemical
technology, preparing them for leadership roles
in the industry or advanced study in the field.
Graduates would be well-positioned with skills and
knowledge for problem-solving and adapting to
evolving global trends in science,technology and
business to meet the growing challenges of the in-
dustry.

Master's Degree programme
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ADVANCED CHEMICAL ENGINEERING
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El DESCRIPTION

Field of study:

CHEMICALENGINEERING AND TECHNOLOGY
The Master of Chemical Engineering and Technol-
ogy Program aims to provide students with ad-
vanced knowledge, practical skills, and innovative
thinking in the field of chemical engineering and
technology to solve complex industrial challenges.
The program will focus on cutting-edge tech-
nologies, emphasizing the practical application
of engineering principles in solving the problems
of modern society. Graduates will be well-pre-
pared to take on leadership positions in the indus-
try or pursue further studies at the PhD level.
Speciality:

Advanced Chemical Engineering

The programme of studies directly reflects the
current needs of the labour market in the field
of Chemical and Process Engineering, provid-
ing employment opportunities. It is designed
to provide the graduates with the following learn-
ing outcomes: knowledge on developments and
new developments in the field of chemical engi-
neering, ability to use new advances in the field
of chemical engineering, basic understanding
of the processes of governance, knowledge
of the functions, principles and management in-
struments, including quality management and
identification of the main problems of manage-
ment, knowledge of the design of process devices
and systems, integration and process intensifica-
tion, performing a complete process design, the
use of computer technology, including tools for
exploring and simulating the dynamics of vari-
ous processes. Advanced Chemical Engineering
combines classical chemical engineering with
bioprocess engineering, nanoengineering, chemi-
cal technology and environmental engineering.
The graduation document certifies the degree
in engineering chemistry with the notification
of a deepened specialization in Advanced Chemi-
cal Engineering. Study for applicants without engi-
neering degree study lasts 2 years, otherwise 1.5
years only.

ABOUT STUDIES

» Duration: 3 or 4 semesters
»  Mode of study: Full time
» Language of instruction: English

»  Start date: October 2025 - 4 semesters for
candidates without engineering degree
February 2026 - 3 semesters

» Programme coordinator:
Piotr Rutkowski, PhD, DSc, Prof. at Wroctaw Tech

JOB PROSPECTS

The graduate has extended knowledge of mathematics, natu-
ral sciences and technical skills: professional solving of prob-
lems in the field of chemical engineering, conduct advanced
research experiments, propose and optimize new solutions
and independently analyse problems related to chemical and
process engineering. The graduates are prepared for creative
work in the design and operation of processes in the chemical
industry. The graduate is prepared to run the own business.

ENTRY INFORMATION

Requirements: Bachelor's or Bachelor of Engineering De-
gree in Chemical Engineering or related domains (3-se-
mester programme). Each application is assessed individ-
ually on its merits. If in doubt, please contact an Admission
Officer, e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of accepted
language certificates can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +4871320 3711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF CHEMISTRY

FIELD OF STUDY: | CHEMICAL ENGINEERING AND TECHNOLOGY 29
| ADVANCED CHEMICAL ENGINEERING | MASTER'S DEGREE PROGRAMME

CONTENT

The main study of Advanced Chemical Engineering consists of at least 23 units, covered as lectures, labs and
seminars. In addition, some optional units are offered covering also language courses.

SEMESTER O

» Informatics for Engineers

» Biotechnology with Introduction to Industrial
Microbiology

» Basics of Technical Drawing

» Technical Safety in Industry

» Material Recovery and Recycling

» Fundamentals of Chemical and Process
Engineering

» Bioreactors

» Introduction to Materials Science and Engineering

» Fundamentals of Chemical Technology Design

» Separation and Purification of Products

SEMESTER 1

» Trends in Chemical Engineering and Technology

» Membrane Processes

» Chemical Processes Equipment

» Heterogeneous Reactors

» Retrieval of Scientific and Technological Resources
» Mathematics for Engineers

» Managerial Course |

» Managerial Course Il

» Foreign Language |

» Graduation Proseminar

SEMESTER 2

» Chemical Processes Project with CFD Calculations
» Biocatalysis in Food, Brewery
and Pharmaceutical Industry
» Numerical Applications in Nanoengineering
» Nanotechnology
» Green Chemistry and Sustainable Technology
» Foreign Language Il
» Graduate Laboratory |

SEMESTER 3

» Chemical Process Optimization and Management
» Elective course

» Graduate Laboratory Il

» Graduation Seminar

Master's Degree programme
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COMPUTER ENGINEERING

El DESCRIPTION ABOUT STUDIES

» Duration: 3 semesters

The final effect of studies at the Master's level is ob-
taining knowledge, skills and qualifications in according »  Mode of study: Full time

to "Teaching Standards" in the field of Computer Sci- » Language of instruction: English
ence. Students receive extended knowledge in speciali-
sation. Graduates will be able to: use various methods
and techniques, formulate and solve specific problems » Programme coordinator:
related to computer science, become teamwork leaders. Elzbieta Kukla, PhD

Additionally, they will have obtained fluent and creative
knowledge application in the area of the specialisation,
which means mathematical models designing, problem
formulating an.d solvmg,.problem-orlented information JOB PROSPECTS
systems analysis and testing.

» Start date: February 2026

Employment in IT companies and organisa-
tions which apply informatics tools and sys-
tems at the specialists and manager positions.

ENTRY INFORMATION

Requirements: Bachelor's Degree, prefer-
ably in Computer Science or in a related field.
Applicants with a Bachelor's Degree outside
of Computer Science must demonstrate signifi-
cant proficiency in computer science. Any area
of requirements can be satisfied through cours-
es completed at the bachelor level or by relevant
experience.

Each application is assessed individually on its
merits. If in doubt, please contact an Admission
Officer, e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 3711, +48 71320 3170, +48 71320 3719, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF INFORMATION AND COMMUNICATION TECHNOLOGY
FIELD OF STUDY: | APPLIED COMPUTER SCIENCE |

COMPUTER ENGINEERING |
MASTER'S DEGREE PROGRAMME

CONTENT

Forms of teaching: lectures, laboratories, tutorials, projects, seminars, research.

SEMESTER 1

» Advanced Cybersecurity Issues

» Advanced Databases

» Analysis of Web-based System

» Foundations of Knowledge Engineering

» Software System Development

» Methods of planning and analyzing
experiments

» Physics of Contemporary Computer Science

» Lectorate 2.2

SEMESTER 2

» Advanced Topics in Artificial Intelligence
» Project Management

» Recent Advances in Computer Science

» Research Methodology

» User Experience

» Monograph Project

» Fundamentals of Business and Intellectual
Property

» Lectorate 2.1

SEMESTER 3

» Mobile and Multimedia Systems
» Video Game Design

» Diploma seminar

» Master Thesis

» Ethics of New Technologies

Master's Degree programme




ADVANCED COMPUTER SCIENCE

El DESCRIPTION

The ACS studies’ programme is focused on delivering
multidisciplinary knowledge and developing theoreti-
cal and practical skills in modern areas of computer
science (Machine Learning, Neural Networks, opti-
misation, etc.), information technology and comput-
er systems. We believe that students gain the most
when they are involved in research (working on pro-
jects) individually and as a team while the lecturer is
ready to advise and guide. Therefore, more than 65%
of the course’s programme is focused on active forms
of learning like group projects, seminars, classes (tu-
torials) and laboratory training. ACS (formerly known
as AIC - Advanced Informatics and Control) shapes
many successful PhD candidates and researchers.
Historically speaking, we have had 25 double diploma
students and 11 PhDs with the cooperation of foreign
universities.

JOB PROSPECTS

ENTRY INFORMATION

Requirements: Bachelor's Degree in In-
formatics, Computer Science, Computer
Engineering, Information Technology, Tel-
einformatics, Computer Systems, Robotics,
Control, Control Engineering, Systems, Elec-
tronics, Telecommunications. Each applica-
tion is assessed individually on its merits. If
in doubt, please contact an Admission Of-
ficer, e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of
accepted language certificates can be
checked online.

The graduates will gain deep knowledge in computer sci-
ence (Machine Learning, algorithms, optimisation) and
software engineering. They will be prepared to solve
real-life IT and computer science problems, conduct
proper research and learn how to gain information
from the literature and other available sources. The
alumnus will be prepared for a role of a team leader
and have extensive teamwork skills (critical thinking,
collaboration, communication etc.). They will have ex-
perience in both organising and participating in work-
shops/conferences. They will acquire the experience
necessary for a professional career at research units,
universities, colleges, and industry. In addition, they
will develop English communication skills that are well
above industry standards.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
» Start date: February 2026

» Programme coordinator:
Wojciech Kmiecik, PhD

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF INFORMATION AND COMMUNICATION TECHNOLOGY
FIELD OF STUDY: | COMPUTER ENGINEERING |

ADVANCED COMPUTER SCIENCE |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 SEMESTER 3

» Research Skills and Methodologies » Research Project 2

» Optimisation Methods: Theory » Natural Language Processing
and Applications » Introduction to Computer Vision in Quality

» IT Applications: Electronic Media Control

» in Business and Commerce » Entrepreneurship

» Information Systems Modelling » ACS Diploma Seminar 2

» Computer Project Management » Final Project (MSc Thesis)

» Discrete Mathematics

» Social Communications

» Foreign Language/Polish Language |

» Physics

SEMESTER 2

» Machine Learning

» Neural Networks

» Research Project

» Secure Systems and Networks

» Modelling and Optimisation of Computer
Networks

» Information and Storage Management

» ACS Diploma Seminar 1

» Foreign Language/Polish Language Il

Master's Degree programme
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INTERNET ENGINEERING

= DESCRIPTION

The programme is focused on delivering knowledge and
developing skills needed for a successful career in Com-
puter Science and Engineering, particularly in designing
and maintaining complex service-oriented information
systems. It develops abilities to solve non-routine prob-
lems and to formulate opinions based on incomplete
information. The programme covers professional topics
as well as R&D teamwork. Special attention is given to
the ability to work in multinational industrial teams. The
curriculum covers software development and analysis,
networking, web services, human interfaces, and security
of complex information systems.

JOB PROSPECTS

The graduates will have knowledge and skills
needed for a careerin computer and software
organisations, research units, industry, gov-
ernment administration, and education. They
will be particularly well prepared to work
on the implementation and maintenance
of new-generation web services. They will
have the experience necessary for a profes-
sional career and undertake level Il (Ph.D.)
education. In addition, they will possess well
above standard skills in communication in mul-
tinational teams.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
» Start date: February 2026

» Programme coordinator:
Prof. Czestaw Smutnicki, PhD, DSc, Eng

ENTRY INFORMATION

Requirements: Bachelor's Degree in Com-
puter Science, Computer Engineering, Infor-
mation Technology, Informatics, Teleinfor-
matics, Telecommunication or related. The
degree must be obtained in an engineering
programme of studies of at least 3.5 years du-
ration (equivalent to 210 ECTS ).

Each application is assessed individually on its
merits. If in doubt, please contact an Admis-
sion Officer, e-mail:

admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

»  English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of
accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF INFORMATION AND COMMUNICATION TECHNOLOGY
FIELD OF STUDY: | COMPUTER ENGINEERING |

INTERNET ENGINEERING |
MASTER'S DEGREE PROGRAMME

CONTENT

The programme includes traditional lectures and hands-on study forms (mainly laboratories and design pro-
jects). In the 3 semester, the student is also required to complete a final individual project and write a thesis
on its basis. The diploma examination, the passing of which is required to obtain the Master's title, covers topics
of the completed courses and the thesis presentation. The courses delivered in each semester are as follows:

SEMESTER 1 SEMESTER 3
» Research Skills and Methodologies » Application Programming: Data Mining and Data
» Optimisation Methods: Theory and Warehousing
Applications » Application Programming: Mobile Computing
» IT Applications in Business and Commerce » |E Seminar
» Information Systems Modelling » Final Project
» Computer Project Management » Entrepreneurship
» Discrete Mathematics

» Social Communications
» Foreign Language/Polish Language |
» Physics

SEMESTER 2

» Multimedia and Computer Visualisation

» Application Programming - Java and XML
Technologies

» Information Systems Analysis

» Advanced Databases

» Secure Systems and Networks

» Softcomputing

» Foreign Language

Master's Degree programme
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CONTROL IN ELECTRICAL POWER

ENGINEERING

El DESCRIPTION

The students can spend full duration of the studies
at Wroctaw University of Science and Technology
(Wroctaw Tech) or benefit from the Double-Degree
option. The joint double degree programme is run to-
gether with Toronto Metropolitan University (TMU)
in Toronto, Canada (possibility of exchange for Pol-
ish and Canadian citizens only) and Brandenburg
University of Technology (BTU) in Cottbus, Germany,
University of Palermo (UNIPA), Italy, RWTH Aachen
University, Aachen (Germany). The goal of the pro-
gramme is to improve the quality of graduate-level
education and training in the field of control en-
gineering. It is focused on new and challenging is-
sues of power system automation and control. The
programme offered by the Faculty of Electrical En-
gineering is split up into four semesters, including
a Master's Thesis semester and a 4-week industrial
placement. Students have the opportunity to spend
either their first or second year at a partner univer-
sity, depending on their chosen institution. During
their second year, they will undertake the writing of
their thesis at the host university.

ABOUT STUDIES

» Duration: 4 semesters

»  Mode of study: Full time

» Language of instruction: English
» Start date:

» October 2025 at Wroctaw Tech or BTU
(Double Degree Programme),

» September 2025 at TMU
(Double Degree Programme)

» September 2025 at UNIPA
(Double Degree Programme)

» Programme coordinator:
Prof. Robert Lis

JOB PROSPECTS

The programme is devoted to the candidates
interested in work related to electric power
system control, reliability, transmission and
distribution of electrical energy, protection and
decision-making in power systems, energy mar-
ket issues, etc.

ENTRY INFORMATION

Requirements: Bachelor's Degree in Electrical
Engineering or related field.
Each application is assessed individually on its
merits. If in doubt, please contact an Admission
Officer, e-mail: admission@pwr.edu.pl
» Deadline for application for full
programme at Wroctaw Tech:
www.admission.pwr.edu.pl
» Deadline for application for double
degree programme:
» https://weny.pwr.edu.pl/en/candidates/
application-deadlines

» Tuition fee
» Application fee

»  English: Equivalent of minimum TOEFL IBT
— 87 points or 6,5 (7,0 at RU) points IELTS.
List of accepted language certificates can
be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF ELECTRICAL ENGINEERING
FIELD OF STUDY: | ELECTRICAL ENGINEERING |

| CONTROL IN ELECTRICAL POWER ENGINEERING |
MASTER'S DEGREE PROGRAMME

CONTENT

COURSES AT WROCLAW TECH: COURSES AT UNIPA:
SEMESTER 1 https://wroclaw.tech/UNIPA-courses

» Numerical and Optimisation Methods

» Power Quality Assessment

» Power Systems Faults

» Fault Calculations

» Dynamics and Control of AC and DC Drives

» Circuits and Systems

» Advanced Technology in Electrical Power
Generation

» Foreign Language — Al or A2

» Foreign Language — B2+ or C1+

SEMESTER 2
» Digital Control Techniques
» Simulation and Analysis of Power System
Transients
» Digital Signal Processing for Protection
and Control
» Power System Protection
» Fibre Optics Communications and Sensors
» Renewable Energy Sources
» Electric Power System Operation and Control
» Diploma Placement 4 Weeks
» Elective Course from Management Block

SEMESTER 3

» Advanced High Voltage Technology

» Artificial Intelligence Techniques

» Power System Automation and Security
» Electrical Power Systems Management
» Electromagnetic Compatibility

» Measurement Methods and Techniques
» Diploma Project

» Elective Courses from Law Block

COURSES AT RWTH:
https://wroclaw.tech/RWTH-courses

COURSES AT TMU:
https://wroclaw.tech/RU-courses

COURSES AT BTU:
https://wroclaw.tech/BT-courses

SEMESTER 4

» Diploma Seminar

» Master’s Thesis

» Elective course from Social Sciences and Ethics
Block

» Elective Course from A Block and B Block

Master's Degree programme
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RENEWABLE ENERGY SYSTEMS

= DESCRIPTION

The students of the programme can spend full dura-
tion of the studies at Wroctaw University of Science
and Technology (Wroctaw Tech) or benefit from the
Double-Degree option. The DD option is a proposal
for a limited number of the best applicants. Stu-
dents spend one year in Wroctaw and one year at
a partner university (depending on the institution,
this may be the first or second year). They write
their thesis at the university where they spend
their second year. They can choose the double de-
gree option with the University of Palermo (UNIPA),
Italy, the Otto von Guericke University Magdeburg
(OVGU), Germany, or Lappeenranta-Lahti Univer-
sity of Technology (LUT), Finland. In each case, the
thesis is written at the institution where they spend
their second year. The programme is focused on the
modern issues related to renewable energy sources
and their integration in power system.

JOB PROSPECTS

The programme is devoted to the candidates
interested in work related to renewable energy
systems, reliability, transmission and distribu-
tion of electrical energy, protection and deci-
sion-making in power systems, energy market
issues, etc.

ABOUT STUDIES

» Duration: 4 semesters

»  Mode of study: Full time

» Language of instruction: English
» Start date:

» October 2025 at Wroctaw Tech or OvGU
(Double Degree Programmes)

» September 2025 at UNIPA
(Double Degree Programme)

» Programme coordinator:
Prof. Robert Lis

ENTRY INFORMATION

Requirements: Bachelor's Degree in Electrical

Engineering or related field.

Each application is assessed individually on its

merits. If in doubt, please contact an Admis-

sion Officer, e-mail: admission@pwr.edu.pl

» Deadline for application for full

programme at Wroctaw Tech:
www.admission.pwr.edu.pl

» Deadline for application for double
degree programme:

https://weny.pwr.edu.pl/en/candidates/
application-deadlines

» Tuition fee
» Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF ELECTRICAL ENGINEERING
FIELD OF STUDY: | ELECTRICAL ENGINEERING |

RENEWABLE ENERGY SYSTEMS |
MASTER'S DEGREE PROGRAMME

CONTENT

courses at WROCLAW TECH:
SEMESTER 1

» Numerical and Optimisation Methods

» Power Quality Assessment

» Power Systems Faults

» Fault Calculations

» Dynamics and Control of AC and DC Drives

» Circuits and Systems

» Advanced Technology in Electrical Power
Generation

» Foreign Language — Al or A2

» Foreign Language — B2+ or C1+

SEMESTER 2

» Power Electronics

» Simulation and Analysis of Power System
Transients

» Protection and Control of Distributed Energy
Sources 1

» Renewable Energy Sources

» Water Power Plants 1

» Integration of Distributed Resources in Power
Systems

» Electromechanical Systems in Renewable Energy

» Modelling of Electrical Machines

» Diploma Placement 4 Weeks

» Elective Course from Management Block

» Energy Storage Systems

SEMESTER 3

» Photovoltaic Cells

» Protection and Control of Distributed Energy
Sources 2

» Water Power Plants 2

» Industrial Ecology - Selected Problems

» Artificial Intelligence Techniques

» Legal Regulations and Investments in Power
Systems with Distributed Energy Sources

» Electromagnetic Compatibility

» Measurement Methods and Techniques

» Diploma Project

» Elective Courses from Law Block

SEMESTER 4

» Diploma Seminar

» Master’s Thesis

» Elective Course from Social Sciences and Ethics
Block

» Elective Course from A Block and B Block

courses at OvGU:

SEMESTER 3

» Power Electronics

» Power Network Planning and Operation

» Digital Info Processing

» Electromagnetic Field Theory

» Power System Economics and Special Topics
» Project

SEMESTER 4

» Master’s Thesis

COURSES OVGU:
https://www.ovgu.de/unimagdeburg/en/Study/

COURSES LUT:
https://www.lut.fi/en/studies/technology/

COURSES UNIPA:
https://offertaformativa.unipa.it/offweb/public/

Master's Degree programme
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MINING ENGINEERING

El DESCRIPTION ABOUT STUDIES

Graduate's profile: A graduate will possess abilities to » Duration: 3 semesters
use in-depth knowledge of problems within the domain
of basic sciences, main-field-of-study and specialisation

»  Mode of study: Full time

subjects. The graduate will be able to manage and super- »  Language of instruction: English

vise teams, deal with high-risk situations and decisions, » Start date: October 2025 and February 2026
and use competently the knowledge of law and econom- » Programme coordinator:

ics. The graduate will be prepared to design technological Gabriela Paszkowska, PhD, DSc,

processes, carry out research work and work creatively. Prof. at Wroctaw Tech

gabriela.paszkowska@pwr.edu.pl

. JOB PROSPECTS

The Mining Engineering graduate will be pre-
pared to work for enterprises, engineering super-
vision bodies, state administration, design offices
and research units, where in-depth specialised
knowledge of mining engineering and geology
is demanded.

ENTRY INFORMATION

Requirements: Bachelor's Degree — Bachelor
of Science or Bachelor of Engineering (any incl.
Geology Engineering, Mining Engineering, Me-
chanical Engineering, Energy-related Engineer-
ing studies etc.).

Each application is assessed individually on its
merits. If in doubt, please contact an Admis-
sion Officer, e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

»  English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points |ELTS.
List of accepted language certificates
can be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF GEOENGINEERING, MINING AND GEOLOGY

FIELD OF STUDY: | MINING AND GEOLOGY | MINING ENGINEERING |
MASTER'S DEGREE PROGRAMME

CONTENT

Knowledge will be provided in the form of lectures, tutorials, laboratories, computer labs, project works

and seminars.

SEMESTER1

» Theory and Practice in Geomechanics

» Computer-Aided Geological
Modelling & Geostatistics

» Project Management, Appraisal
and Risk Evaluation

» Engineering Geophysics

» Integrated Analysis of Deformations
in Geomechanical Engineering

» Occupational Health and Safety

» Excavation Design in Open Pit Mining

SEMESTER 2

» Machinery Systems

» Tunnel and Underground Excavation Design
» Computer-Aided Mine Design

» Ventilation and Mine Fires

» Issues in Nuclear Physics

» AutoCAD

» Foreign Languages

» Free Elective

SEMESTER 3

» Mineral Processing Systems

» Environmental Management

» Digital Mine

» Operations Research

» Free Elective

» Diploma Seminar, Master's Thesis

Master's Degree programme
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A9 GEOTECHNICAL AND ENVIRONMENTAL

ENGINEERING

El DESCRIPTION ABOUT STUDIES

This is a joint MSc programme of Wroctaw Tech and Uni- » Duration: 3 semesters
versity of Miskolc (Hungary) formatted as a structured stu-
dent mobility. Wroctaw Tech students study two semesters
in Wroctaw (the first and the third semesters) while the sec-

»  Mode of study: Full time

» Language of instruction: English

ond semester is offered by University of Miskolc. Students » Start date: February 2026

apply for an Erasmus Plus grant for the mobility period. » Programme coordinator:

In the third semester, the students write and defend their Gabriela Paszkowska, PhD, DSc,
Master's thesis at Wroctaw Tech. Prof. at Wroctaw Tech

Graduate profile: An alumnus becomes a specialist in two gabriela.paszkowska@pwr.edu.pl

fields: geotechnical and environmental engineering, which
is a very unique profile. Besides that, a graduate will be able JOB PROSPECTS
to apply in-depth knowledge of basic sciences. The gradu-

ate will be able to manage and supervise teams, deal with
high-risk situations and decisions. The graduate will be pre-
pared to design technological processes, carry out research
work, and work creatively.

The graduate will be prepared to work for en-
terprises, engineering supervision bodies, state
administration, design offices and research units,
where in-depth specialised knowledge of min-
ing, geology and geotechnical engineering is de-
manded.

ENTRY INFORMATION

Requirements: Bachelor's Degree — Bachelor
of Science or Bachelor of Engineering (any incl.
Geology Engineering, Mining Engineering, Me-
chanical Engineering, Energy Related Engineer-
ing Studies, etc.).

Each application is assessed individually on its
merits. If in doubt, please contact an Admission
Officer, e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

»  English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF GEOENGINEERING, MINING AND GEOLOGY
FIELD OF STUDY: | MINING AND GEOLOGY |

| GEOTECHNICAL AND ENVIRONMENTAL ENGINEERING |
MASTER'S DEGREE PROGRAMME

CONTENT

seminars.

Knowledge will be provided in the form of lectures, tutorials, laboratories, computer labs, project works and

SEMESTER1

» Theory and Practice in Geomechanics

» Computer-Aided Geological
Modelling & Geostatistics

» Project Management, Appraisal and Risk
Evaluation

» Engineering Geophysics

» Integrated Analysis of Deformations
in Geomechanical Engineering

» Occupational Health and Safety

» Environmental Chemistry

SEMESTER 2

» Methods of Environmental Assessment

» Waste Incineration and Air Quality Protection

» Water and Wastewater Treatment

» Environmental Geotechnics

» Chemical Technologies in Environmental
Protection

» Environmental Risk Assessment and Remediation

» Soil Chemistry

» Numerical Methods and Optimisation

» Quality Management

» Basics of Waste Management

» Environmental Geology

» Foreign Languages

SEMESTER 3

» Mineral Processing Systems

» Excavation Design in Open Pit Mining
» Digital Mine

» Free Elective

» Foreign Languages

» Diploma Seminar, Master's Thesis

Master's Degree programme
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44 GEOMATICS FOR MINERAL RESOURCE = &%=

MANAGEMENT

W

El DESCRIPTION

Geomatics for Mineral Resource Management focuses
on the process of resource modelling and mine man-
agement. Students will be taught in a variety of sub-
jects related to the field mining and mineral resources.
This includes financial, environmental, political as well
as the legal aspects of national and international min-
ing projects. In addition to the standard courses taught
by staff from partner universities and industry experts,
massive open online courses (MOOC's) are offered for
the students. The MOOC’s consist of a series of web-
videos, which cover the content of an individual course.
The educational content focuses on the following pil-
lars: (1) Sensing technologies for mine data gathering,
(2) Spatial (big) data management and visualisation and
(3) Spatial (big) data analysis and modelling. The aim
of the programme is to enable students to integrate these
three pillars into innovative Geomonitoring concepts.
Students, who decide on the specialisation Geomatics
for Mineral Resource Management, are, on default,
set to study 2 semesters at Wroctaw University of Sci-
ence and Technology (1% and 4™ semesters) and 2 se-
mesters at TU Bergakademie Freiberg in Germany or
two semesters at Montanuniversitat Leoben in Austria
(2" and 3 semesters) and are going to graduate with
a double MSc diploma.

ABOUT STUDIES

» Duration: 4 semesters

»  Mode of study: Full time

» Language of instruction: English

» Start date: February 2026

» Programme coordinator:
Jan Blachowski PhD, DSc, Prof. (at Wroctaw
Tech)
Jorg Benndorf PhD, DSc, Prof. (at TUBAF)
Alexander Tscharf PhD (at MUL)

JOB PROSPECTS

Thus graduate of this master program will
be prepared to work in an international and
multicultural environment in mining and ex-
ploration companies, technical supervision
authorities, public administration offices, re-
search and development institutions, every-
where where advanced and state of the art
Interdisciplinary knowledge of mining and
geology, computer aided design, geomatics
are required.

ENTRY INFORMATION

Requirements: the programme is meant
for holders of a Bachelor's Degree in Mining
and Geology as well as a Bachelor's Degree
in Geodesy and Cartography or related engi-
neering disciplines.

Each application is assessed individually on its
merits. If in doubt, please contact an Admis-
sion Officer, e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee
» Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF GEOENGINEERING, MINING AND GEOLOGY
FIELD OF STUDY: | MINING AND GEOLOGY |

| GEOMATICS FOR MINERAL RESOURCE MANAGEMENT |
MASTER'S DEGREE PROGRAMME

CONTENT

Knowledge will be provided in the form of lectures, tutorials, laboratories, computer labs, project works and seminars.

SEMESTER 1 (WROCtAW TECH)

» Principles and Application of InSAR and GIS
in Mining

» Computer Aided Geological
Modelling & Geostatistics

» Project Management, Appraisal and Risk
Evaluation

» Engineering Geophysics

» Integrated Analysis of Deformations
in Geomechanical Engineering

» Occupational Health and Safety

» Foreign language

» Elective course

» Mine Operation Scheduling and Costing

SEMESTER 2 (TUBAF)

» Applied Remote Sensing in Geosciences

» Underground Mine Surveying

» Geomonitoring

» Operations Management

» Geomodelling — Geostatistics for Natural
Resource Modelling

» Foreign language

SEMESTER 2 (MUL)

» Spatial Planning

» Deposit Modelling and associated Software

» Underground Mining

» Mining Subsidence Engineering

» Geotechnical Monitoring and Instrumentation
» CAD-Constructions in Tunneling

» Mine Surveying Project Study

SEMESTER 3 (TUBAF)

» Special Topics Geokinematics

» Applied Spatial Data Analysis and Modelling -
Case Study

» Geomatics for Mineral Resource and

» Reserve Management

» Reclamation

» Human Resources Management &
Organizational Behaviour

» Elective courses

SEMESTER 3 (MUL)

» Rock Mechanics — Open Pit, Slopes, Dams

» Lab in Rock Mechanics

» Applied Geodesy

» Selected Aspects of Engineering Surveying
in Mining and Tunneling

» Mine Mapping

» Regulation of Mining Damages and Ensuring
Land Use

» Risk Management in Mines

» Environmental Aspects of Mineral
Extraction

» Internship

» Elective courses

SEMESTER 4 (WROCLAW TECH)

» Master's Thesis
» Diploma Seminar

Master's Degree programme
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GEOMATICS

= DESCRIPTION

Geomatics is an interdisciplinary scientific and
technical discipline that combines aspects of sur-
veying and sensor technology with data process-
ing, geoinformatics and geomodelling. It deals
with the acquisition, analysis, interpretation,
dissemination and practical application of geoin-
formation. Geomatics analyses and synthesises
information about spatial processes and phenom-
ena and their changes. Geodata is used to create
precise computer models that help us to better
understand spatial processes and shape future
activities. Geodata is an element of almost eve-
ry intelligent IT system. Stimulating the demand
for geoinformation may affect the innovativeness
of the economy and allow the entrepreneurs and
science to play a significant, more noticeable role
of on the global market.

The universality of geoinformation and the pros-
pect of a further increase in its use (processing
and analysing large collections of geodata) gen-
erate a demand for specialists in the field of de-
velopment and management of geoinformatics
knowledge. Education in the field of Geodesy and
Cartography with a specialisation in Geomatics
at the Faculty of Geoengineering, Mining and Ge-
ology of Wroctaw University of Science and Tech-
nology meets this demand.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
»  Start date: February 2026

» Programme coordinator:
Jan Blachowski PhD., DSc, Prof. at Wroctaw Tech

JOB PROSPECTS

The Geomatics graduate will be prepared
to work for enterprises, engineering su-
pervision bodies, state administration,
design offices and research units, where
in-depth specialised knowledge of mod-
ern geodetic and remote sensing tech-
niques of spatial data acquiring, as well as
further advanced analyses in Geographic
Information Systems and visualisations
are required.

ENTRY INFORMATION

Requirements: the programme is meant
for holders of a first-degree diploma in
engineering studies, especially in the field
of geodesy and cartography.

Each application is assessed individually
on its merits. If in doubt, please contact
an Admission Officer, e-mail:

admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can
be checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF GEOENGINEERING, MINING AND GEOLOGY

FIELD OF STUDY: | GEODESY AND CARTOGRAPHY | GEOMATICS |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 SEMESTER 3

» Physics - the structure of matter » Geoinformation Project Management

» Advanced Numerical Calculation Methods » Selected Topics in Information Technologies
» Advanced Geospatial Analysis » Distributed Spatial Databases

» Geostatistics » Management of Company Development

» Special Measurements » Graduate Seminar

» Selected Topics in GNSS » Elective course

» GIS Programming » Master's thesis

» Foreign Language |

SEMESTER 2

» Selected Topics in Geospatial Modelling

» Financial Analysis

» Physical Geodesy

» Digital Cartographic Models

» GIS Programming Il

» Remote Sensing and Processing of Digital Images
» Hydrology Il

» Selected Topics in Displacement Monitoring
» Foreign Language

» Elective course

» Humanistic-managerial course

» Graduate Seminar

Master's Degree programme
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ENVIRONMENTAL QUALITY

MANAGEMENT

DESCRIPTION

Environmental Quality Management — is a ver-
satile field of study created for students eager
to extend environmental protection general
knowledge to higher level of proficiency. It of-
fers their graduates possession of the compre-
hensive knowledge developed simultaneously
with practical skills, focusing on the environ-
mental protection issues with the engineering
— related taste. Graduates are able to solve en-
vironmental engineering problems associated
with sustainable development, circular econo-
my, renewable energy resources, the pollution
of environment and climate changes. Engineer-
ing skills possessed in planning, designing and
conducting research projects allows our alumni
to exploit their knowledge as highly skilled pro-
fessionals solving problems related to water
supply and sewer systems, wastewater process-
ing, air protection, solid waste management and
even materials science. We focus on biodegrad-
able materials as a substituents for petroleum
based plastics, smart renewable energy sector
and other emerging technologies and processes
being a huge step forward to existently utilised
ones.

. JOB PROSPECTS

The graduates will be qualified for work-
ing in research and development institutes,
enterprises and governmental units related
to environment protection issues. Knowledge
and skills allows to take advantage to work
in design offices and enterprises which are
involved in: water supply, wastewater treat-
ment, waste management, contaminated land
remediation, broad spectrum of renewable
energy technologies, air pollution control and
abatement.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
»  Start date: October 2025

» Programme coordinator:
Martyna Grzegorzek, PhD Eng

0—0:

) ENTRY INFORMATION

Bachelor's Degree in either of the following:
Environmental Protection, Environmental En-
gineering, Chemistry, Earth Sciences.

Each application is assessed individually on its
merits. If in doubt, please contact an Admis-
sion Officer, e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF ENVIRONMENTAL ENGINEERING
FIELD OF STUDY:

| ENVIRONMENTAL QUALITY MANAGEMENT |
MASTER'S DEGREE PROGRAMME

CONTENT

Forms of teaching: lectures, laboratories, seminars, classes, computer classes, projects.

SEMESTER 1

» Environmental Chemistry

» Engineering Application of Mathematical
Statistics

» AutoCAD

» Water Treatment Technology

» Raw Materials Management

» Sanitary Biology

» Water Quality Management

» Water Supply Systems

» Automation in Environmental Engineering

» Polish Language Al or English Language C1+

» Elective Subject

» Ethics of New and Emerging Technologies

» Strategic Management

SEMESTER 2

» Environmental Management

» Membrane Separation Processes in
Environmental Protection

» Environmental Toxicology

» Waste Gases Purification

» Solid Waste Management

» Wastewater Treatment Technology

» Biodegradable Materials

» Sewage Systems

» Environmental Health Hazards

» Polish Language or Another Language

» Spatial Planning

» Reliability of Engineering Systems

SEMESTER 3

» Organization of Construction Works
» Building Regulation

» Renewable Energy Systems

» Elective Subject

» Diploma Seminar

» Diploma Project

Master's Degree programme
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BUSINESS INTELLIGENCE

.
W
6§63

DESCRIPTION

Businesses today collect an incredible amount of data,
from market transactions, customer service interactions,
social media reviews, search engine entries, to demo-
graphics, and many more. Businesses also experience
a rapid and continuous development of technologies and
organizational behaviour that require high skills in ICT
and data analytics. The Master of Business Intelligence
(BI) programme is designed to provide students with cut-
ting edge managerial knowledge and a strong foundation
in both analytics —including computational statistics and
machine learning — and core business areas, building
a solid platform for a successful career. The Bl curriculum
focuses on how to analyse data in order to identify and
predict patterns and on how to visualise and present re-
sults to support managerial decisions and lead to innova-
tive thinking in today’s organisations.

The Master of Business Intelligence programme is tai-
lored for current Bachelor of Engineering students and
recent graduates who plan to pursue a career in business
analytics and management information systems, as well
as computer programmers, mathematicians, physicists
and engineers seeking career advancement or change.
We not only welcome students from different back-
grounds and cultures, but also see them as critical for
developing innovative ideas. Set up and run by a team
of top-ranking scientists, award-winning early stage re-
searchers and successful professionals, the Bl curriculum
answers the market demand for tech-savvy graduates
who can apply advanced computational tools to solve
business challenges.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
»  Start date: February 2026

» Programme coordinator:
Katarzyna Maciejowska, PhD

» Contact person: Yash Chawla, PhD

. JOB PROSPECTS

The demand for business analytics is high.
Graduates who complete the Business Intelli-
gence programme will acquire computational
skills and management expertise that the busi-
ness world is actively seeking. Our programme
prepares students for data-driven decision
support that is crucial for today’s business
activities across a broad range of industries,
including ICT, financial, energy and health-
care. The Bl curriculum provides the skills
to fill positions not only as business intelli-
gence analysts, but also data analysts and con-
sultants, revenue optimisation analysts, risk
managers, market analysts and many more.
Given that the students will have the opportu-
nity to conduct research with affiliated faculty
and senior staff, the programme also prepares
for academic careers, offering a unique set
of competences and invaluable experience re-
lated to decision support for energy markets
and renewable generation, e-business logistics
and trade, and healthcare systems.

ENTRY INFORMATION

Requirements: Bachelor of Engineering Degree. Each
application is assessed individually on its merits. If in
doubt, please contact an Admission Officer, e-mail:
admission@pwr.edu.pl

Deadline for application
Tuition fee
Application fee

English: Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List

of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +4871320 3711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF MANAGEMENT

FIELD OF STUDY: | BUSINESS ENGINEERING | BUSINESS INTELLIGENCE |
MASTER'S DEGREE PROGRAMME

CONTENT

The program is build up from three blocks:

» Data description and analysis, where students learn how to visualize, and explore datasets using
econometric tools, data mining and artificial intelligence

» Simulation techniques, where students learn how to simulate paths of business processes

» Management, where students learn how to use modern management techniques, such as product
management or design thinking

The lectures are accompanied by laboratories and workshops (no traditional classes!).

Students apply Bl methods using advanced programing environments such as Python, R and Matlab.

ACQUIRED SKILLS
AND COMPETENCES

Students will learn how to:

» Use data analytics to stimulate business growth
with quantitative and qualitative skills.

» Stay on top of the latest methods and approaches
in computational statistics and machine learning.

» Use visualization software to identify trends,
explore hypotheses, challenge assumptions,
and create a more detailed, data-driven
understanding of business activities.

» Simulate realistic future paths of all kinds of
business processes.

» Leverage the power of data to make informed
business decisions and thrive in a rapidly changing
environment

» Conduct top-tier research and report the results
to managers, peers and the public.

» Reach the right customers with the right products
and communications.

Master's Degree programme
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HUMAN RESOURCE MANAGEMENT

El DESCRIPTION

People are the most important resource in every organi-
zation. Machines and technology can be purchased or
replicated, but without knowledgeable and skilled indi-
viduals, they hold little value. In today's world, competi-
tion is primarily between teams of people, and Human
Resource Management (HRM) serves as a modern frame-
work for managing such teams. This "soft technology"
enables organizations to transform individual intellectual
capital into HRM capital.

The HRM specialisation equips students with both theo-
retical knowledge and practical skills in strategic and op-
erational human resource management across various
types of organizations, including smaller teams within
them. It also fosters expertise in leadership and team-
building, all grounded in contemporary management,
economics, and finance theories.

Additionally, students will develop the ability to uti-
lize IT tools that support HRM processes. Emphasis will
be placed on understanding business dynamics and ef-
fectively applying management techniques and tools.
Furthermore, students will gain the skills to analyze eco-
nomic and financial phenomena in a rapidly changing en-
vironment.

As part of the HRM specialization, students will also ac-
quire hands-on experience in using IT tools and conduct-
ing data analysis to enhance HRM processes.

JOB PROSPECTS

By completing the second-degree HRM spe-
cialization, graduates will gain the knowl-
edge and competencies needed to lead
various types of teams across different or-
ganizations—from international corpora-
tions to startups—as well as to work as hu-
man resource specialists.

The primary goal of this educational pathis to
equip graduates and professionals from vari-
ous technical fields, including IT, mechanics,
electronics and telecommunications, chem-
istry, construction, and other engineering
disciplines, with the skills to manage and
lead teams in their respective industries.
Graduates of this specialization will acquire
both theoretical knowledge and practical
experience through workshops and hands-
on training, focusing on team dynamics and
group functioning. Additionally, they will
develop expertise in using human resource
management tools to optimize team perfor-
mance—not only in achieving business and
project goals with high efficiency and effec-
tiveness but also in ensuring the well-being
of team members.

ABOUT STUDIES

» Duration: 4 semesters
»  Mode of study: Full time

» Language of instruction:
English

» Start date: October 2025

» Programme coordinator:
Prof. Agnieszka Biertkowska

» Contact person:
Jolanta Maj, PhD

ENTRY INFORMATION

Requirements: Bachelor's Degree or Bachelor
of Engineering Degree. Each application is as-
sessed individually on its merits. If in doubt,
please contact an Admission Officer, e-mail:
admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

»  English: Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF MANAGEMENT

FIELD OF STUDY: | MANAGEMENT | HUMAN RESOURCE MANAGEMENT | 53
MASTER'S DEGREE PROGRAMME

CONTENT

Forms of teaching: lectures, laboratories, tutorials, projects, seminars, research.

15T GROUP OF COURSES:

modern concepts of human resource manage-
ment in the field of selection, assessment and
remuneration of personnel using the competency
approach; management of the development and
potential of employees, as well as their motivation
and engagement; modern trends in the human
resource area (strategic and international HRM,
evidence-based approach, diversity management,
and employer branding).

2"" GROUP OF COURSES:

a set of socio-managerial competences that are
essential in working with and managing people,
including: communication, public speaking and
work on one's own image, working in a group and
understanding group dynamics, social intelligence
and the ability to predict and evaluate the behav-
iour of other people, leadership competences,
including motivating, coordinating the work of a
group and strategic thinking.

3"" GROUP OF COURSES:

General study courses that systematize and ex-
pand knowledge in modern management meth-
ods and concepts, as well as in economics and
finance. The program also includes humanities
courses to enhance critical thinking and commu-
nication skills.

n IMPORTANT!

While studying the HRM specialisation, students
have the opportunity to work both individually
and in a team. The practical forms of classes (i.e.
projects, laboratories or workshops) cover over
50% of ECTS credits. Methods such as case study
and problem-based learning are used.

Students have the opportunity to build specific
tools supporting HR processes. Individual or group
research projects are carried out to solve specific
problems in the field of HRM.

The development of managerial and personal
competences is based on the “learning by doing”
approach, in practice it assumes the workshop
nature of classes. Students develop specific skills,
working in small groups on problems and projects,
take part in simulations of situations and group
processes.

Lectures are conducted in innovative interactive
mode, some are conducted remotely.

At the end of the studies, students are obliged to
prepare an MSc dissertation and pass a final (di-
ploma) exam.

Master's Degree programme
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RENEWABLE SOURCES OF ENERGY

= DESCRIPTION JOB PROSPECTS

A graduate possesses knowledge and skills in the design, The graduate will be prepared to work

testing, and operation of power plants utilizing noncon- in the energy industry. In particular, our

ventional energy sources, encompassing a wide range graduate will have a solid foundation to:

of conversion rates and energy storage methods. » work on the design of equipment using
renewable energy,

» contribute to the development of
innovative solutions in renewable
energy power,

» supervise the operations of renewable
and hybrid energy systems,

» assess the effectiveness of utilizing
renewable energy sources, considering
the location of investments,

» contribute to the determination and
assessment of local and global energy
strategies.

ENTRY INFORMATION

Requirements: Bachelor's Degree in a related
field.

Each application is assessed individually
on its merits. If in doubt, please contact an
Admission Officer, e-mail:

admission@pwr.edu.pl

Deadline for application
@ ABOUT STUDIES Tuition fee

Application fee

» Duration: 3 semesters

»  Mode of study: Full time
» Language of instruction: English » English:

»  Start date: February 2026 Equivalent of minimum TOEFL IBT

— 87 points or 6.5 points IELTS. List

of accepted language certificates can be
checked online.

» Programme coordinator:
Dorota Nowak-Wozny, PhD, DSc, Ass. Prof.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF MECHANICAL AND POWER ENGINEERING

FIELD OF STUDY: | POWER ENGINEERING | RENEWABLE SOURCES
OF ENERGY | MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1

» Applied Mathematics

» Physics - Selected Issues

» Mechatronics and Control Systems

» Selected Problems of Thermal-flow Processes
» New Generation Energy Technologies

» Physics of Renewable Energy

» Modeling of HVAC Systems

» Low-temperature Technologies

» Finite Element Analysis

» Foreign Language min. B2+

SEMESTER 2

» CFD Simulations of Power Generation Units
» Modeling of Energy Systems

» Biomass and Biofuels in Energy Production

» Solar Energy Conversion System

» Fuel Cells and Hydrogen Production

» Water Power Engineering

» Wind Power Plants

» Management Course (Elective)

» Foreign Language (Next Language, Any Level)

SEMESTER 3

» Heat Pumps

» Thermonuclear Power Generation
» Geothermal Power Engineering

» Humanities Course (Elective)

» Master Seminar

» Master Thesis

Master's Degree programme
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REFRIGERATION AND CRYOGENICS

= DESCRIPTION JOB PROSPECTS

A graduate possesses detailed knowledge of devices and The graduates of the Refrigeration and Cryo-
installations dedicated to cooling, reaching tempera- genic program will be prepared to work in all
tures as low as -150°C. In the field of cryogenics, they industrial branches that apply refrigeration
are adept at handling temperatures below 120 K, even and cryogenic technologies. In particular, our
down to fractions of a Kelvin. They have skills in the de- graduates will have a solid foundation to:

sign, implementation, and operation of both refrigera-
tion and cryocooling systems. Additionally, a graduate
can creatively apply modern design methods and is well-
prepared to undertake PhD studies.

» design modern refrigeration and cryogenic
units and installations,

» develop new solutions and methods
for lowering the temperature,

» supervise operations in food cold
stores, refrigeration and air conditioning
installations, air rectification, technical gas
production plants, natural gas liquefaction
plants, and other refrigeration and
cryogenic systems.

ENTRY INFORMATION

Requirements: Bachelor's Degree in Power
or Mechanical Engineering or any related
field. Each application is assessed individu-
ally on its merits. If In doubt, please contact
an Admission Officer, e-mail:
admission@pwr.edu.pl

Deadline for application
@ ABOUT STUDIES Tuition fee

Application fee

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English »  English:
) Equivalent of minimum TOEFL IBT
» Start date: February 2026 — 87 points or 6.5 points IELTS. List
» Programme coordinator: of accepted language certificates can be
Stefan Reszewski, PhD checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF MECHANICAL AND POWER ENGINEERING
FIELD OF STUDY: | POWER ENGINEERING |

| REFRIGERATION AND CRYOGENICS |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 » Cryogenic Systems and Applied
Superconductivity

» Cold Chain

» Humanities Course (Elective)

» Master Seminar

» Master Thesis

» Applied Mathematics

» Physics - Selected Issues

» Mechatronics and Control Systems

» Selected Problems of Thermal-flow Processes
» New Generation Energy Technologies

» Physics of Renewable Energy

» Modeling of HVAC systems

» Low-temperature Technologies

» Finite Element Analysis

» Foreign Language min. B2+

SEMESTER 2

» CFD Simulations of Power Generation Units

» Modeling of Energy Systems

» Cooling Systems

» Applied Cryogenics in Power Engineering

» Air Conditioning Systems

» Vapor-compression Refrigeration Systems

» Cryogenics

» Management Course (Elective)

» Foreign Language (Next Language, Any Level)

SEMESTER 3

» Sorption Refrigeration

Master's Degree programme
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COMPUTER AIDED MECHANICAL

AND POWER ENGINEERING

= DESCRIPTION

A graduate possesses the knowledge and skills in numeri-
cal methods for a wide range of energy/power applica-
tions. This knowledge will be very useful for performing
complex thermal—flow simulations using both commercial
and open-source software. Additionally, the graduate can
utilize artificial intelligence, as well as the conventional ap-
proach, to solve energy/power problems.

JOB PROSPECTS

After graduation, the student will be prepared to solve

problems in practically every area related to thermal and

flow processes. Upon completing the specialization, you

will be able to:

» program in a high-level structured language,

» perform mechanical and thermal-flow simulations
using software such as ANSYS,

» conduct numerical analyses using open-source tools
like OpenFOAM software,

» utilize artificial intelligence to control the operation
of energy devices,

» analyze investments not only in technical terms but
also in economic terms.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
» Start date: February 2026

» Programme coordinator:
Stawomir Pietrowicz, PhD, DSc, Ass. Prof.

ENTRY INFORMATION

Requirements: Bachelor's Degree in arelated
field. Each application is assessed individually
on its merits.

If in doubt, please contact an Admission Officer,
e-mail:

admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF MECHANICAL AND POWER ENGINEERING
FIELD OF STUDY: | POWER ENGINEERING |

| COMPUTER AIDED MECHANICAL AND POWER ENGINEERING |

MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1

» Applied Mathematics

» Physics - Selected Issues

» Mechatronics and Control Systems

» Selected Problems of Thermal-flow Processes
» New Generation Energy Technologies

» Physics of Renewable Energy

» Modeling of HVAC Systems

» Low-temperature Technologies

» Finite Element Analysis

» Foreign Language min. B2+

SEMESTER 2

» CFD Simulations of Power Generation Units

» Modeling of Energy Systems

» Modeling of Combustion Processes

» Advanced Numerical Modeling Using
OpenFOAM

» Fundamentals of Programming

» Advanced Data Processing

» Numerical Methods

» Management Course (Elective)

» Foreign Language (Next Language, Any Level)

SEMESTER 3

» Integrated Production Systems

» Thermodynamic Analysis of Energy Processes
» Artificial Intelligence

» Humanities Course (Elective)

» Master Seminar

» Master Thesis

Master's Degree programme
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AUTOMOTIVE ENGINEERING

]

El DESCRIPTION

At the end of the Master's programme the students
will have a sound base of general scientific knowledge
in the field of Automotive Engineering. The cur-
riculum encompasses contemporary issues related
to automotive industry including innovative design,
materials science, quality, safety and ecology. The
students will be sufficiently equipped and motivated
for a life-long qualification in the field of Automo-
tive Engineering. They will be prepared to implement
their knowledge and to cooperate within an organisa-
tion. In making decisions and performing their
tasks, they will be guided by social, economical and
ecological principles.

JOB PROSPECTS

The graduates will have the professional
knowledge in the range of automotive engi-
neering with particular concern in the latest
trends in vehicle and engine construction
as well as the standards of ecology and op-
eration. The unique programme is designed
to foster the development of the profession-
al skills and to enable the graduates to work
in the international and interdisciplinary
teams in the field of automotive engineering.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
»  Start date: February 2026

» Programme coordinator:
Stawomir Susz, PhD

ENTRY INFORMATION

Requirements: Bachelor's Degree. Each appli-
cation is assessed individually on its merits. If
in doubt, please contact an Admission Officer,
e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF MECHANICAL ENGINEERING |
FIELD OF STUDY: MECHANICAL ENGINEERING AND MACHINE BUILDING | 51

AUTOMOTIVE ENGINEERING |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 SEMESTER 3
» Analytical Mechanics » Automotive Expertises
» Applied Mathematics - Operational Methods in » Diploma Seminar
Automotive » Ecology of Road Transportation
» The basis of negotiations » Master Thesis Il
» Communication for Engineers » Safety of Vehicle
» Design of Engineering Materials

» Energy Efficiency Design of Powertrain and Body
» Fatigue of Materials and Fracture Mechanics

» Machine and Device Control Systems

» Machinery Design Process

» Modelling of Multi-Body Systems

» Surface Engineering

» Testing of Vehicle Elements and Assemblies

» English language

SEMESTER 2

» Developing Engine Technology

» Fluids Mechanics in Automotive Design

» Management for Engineers

» Non Destructive Evaluation in Contemporary
Manufacturing

» Master Thesis |

» Alternative Drive Systems

» Chemistry and Green Fuels E

» Electronics in Car Vehicles

» Foreign Language Il

» BLOCK: Project CAD/FEM

Master's Degree programme
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PRODUCTION MANAGEMENT

DESCRIPTION

The goal of these studies is to provide the students
with knowledge and skills necessary to manage
a production company. The curriculum encompasses
issues related to company management, planning,
organisation and control of manufacturing pro-
cesses. The students learn about the latest methods
of production management and IT techniques es-
sential for the use of computer systems in company
management. The knowledge and skills from many
various disciplines such as: production organisation,
quality management, logistics, computer science,
economics, basics of law, mechanics and construc-
tion of machines, means that their education is uni-
versal and useful in production engineering and ser-
vices in all sectors of the economy.

JOB PROSPECTS

0—0:
o

il  ENTRY INFORMATION

Requirements: Bachelor's Degree in: Control
Engineering and Robotics, Mechanical En-
gineering and Machine Building, Transport,
Management and Manufacturing Engineering
or related.

Each application is assessed individually on its
merits. If in doubt, please contact an Admis-
sion Officer, e-mail: admission@pwr.edu.pl

» Deadline for application
» Tuition fee

» Application fee

»  English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

The graduate of the programme has:

e extended knowledge about the management
of production enterprises, including innovative com-
panies of a global nature, knows the latest produc-
tion technologies and development trends of mod-
ern production enterprises, knows the methods and
techniques of production organisation as well as
methods and tools for optimising production sys-
tems,

¢ the ability to design new production systems and
improving existing companies, is able to effectively
manage production resources as well as plan and
control the implementation of production orders us-
ing advanced IT tools,

e the competence to undertake tasks in enterprises
typical for such functions as: production manager,
product manager, process manager, production en-
gineer, process analyst, process development man-
ager.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
» Start date: February 2026

» Programme coordinator:
Stawomir Susz, PhD

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology



mailto:admission@pwr.edu.pl
mailto:admission@pwr.edu.pl
http://admission.pwr.edu.pl

FACULTY OF MECHANICAL ENGINEERING
FIELD OF STUDY: | MANAGEMENT AND MANUFACTURING ENGINEERING | 53

PRODUCTION MANAGEMENT |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1

» Digitization and Robotization in Industrial
Processes

» Factory Layout Design

» Invention Engineering

» Management and Engineering of Systems
Reliability

» Modeling of Processes in the Enterprise

» Physicochemical Aspects of Manufacturing
Processes

» Social Psychology

» Development of Enterprises Based on Digital
Transformation

» Flexible Manufacturing Automation

» Foreign Language |

» Modern Trends in Production

» Project Management

» Research Methodology

» Reverse Engineering

» Simulation of Manufacturing Processes

SEMESTER 2

» Innovative Manufacturing Technologies

» Intelligent Methods in the Organization of
Production

» Methods of Estimating the Carbon Footprint

» Selected Data Analysis Methods

» Social Product development

» Digitization and Robotization in Industrial
Processes

» Foreign Language Il

» Lean Manufacturing Methods and Tools
» Production Optimization Methods

» Quality Management in Production

» Thesis |

SEMESTER 3

» Diploma Seminar

» Financial Analysis

» Innovative Manufacturing Technologies

» Strategic Management

» Additive Technologies in Production Engineering
» Knowledge Management

» Monitoring and Visualization in Manufacturing
» Product Life Cycle Management

» Thesis Il

Master's Degree programme
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ADVANCED APPLIED ELECTRONICS

= DESCRIPTION ABOUT STUDIES

» Duration: 3 semesters

This course will give the students multidisciplinary
knowledge of electronics, optoelectronics, microwaves »  Mode of study: Full time

and telecommunications. It will enable them to obtain » Language of instruction: English
theoretical and practical knowledge in designing ap-
plied electronic systems based on analogue and digital
techniques, lasers, fibres and microwave electronics as
well as gain expertise in microprocessors, programmable
logic applications and signal processing. Additionally, the
students will gain laboratory experience and become fa-

miliar with work practices of research laboratories. JOB PROSPECTS

» Start date: February 2026

» Programme coordinator:
Jerzy Witkowski, PhD

The graduate will acquire the experience
necessary for a professional career in indus-
try, research units and universities, and will
be prepared for 3" level studies (PhD). They
will gain substantial international experience
working together with highest class scien-
tists in the environment of prestigious labo-
ratories. They will possess well above stand-
ard skills in English communication.

ENTRY INFORMATION

Requirements: Bachelor's Degree in Electrical,
Electronic, Computer Engineering or related dis-
ciplines.

Each application is assessed individually on its
merits. If in doubt, please contact an Admission
Officer, e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF ELECTRONICS, PHOTONICS AND MICROSYSTEMS

FIELD OF STUDY: | ELECTRONICS | ADVANCED APPLIED ELECTRONICS |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 SEMESTER 3

» New Appr. in Electronics and Photonics » Master Thesis

» Microcontrollers Programming » Lab View Programming

» Numerical Methods and Optimization » Computer Networks and Systems
» Numerical methods in differential equations » Entrepreneurship

» Optical Fibers and Optocommunication » Diploma seminar

» Social Communication » Elective courses

» Foreign language

ELECTIVE COURSES:

SEMESTER 2 » Real Time Operating Systems

» DSP Architectures » Optics and Nonlinear Optics

» Hardware Programing » loT Modules

» Lasers and Applications » Electrotechnics

» Analog Peripherals of Digital Systems » Advanced Objective Programming

» RF Circuits Design
» Machine Learning Methods
» Specialization seminar

Master's Degree programme
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EMBEDDED ROBOTICS

= DESCRIPTION

The Embedded Robotics programme combines the
fields of robot control and design with digital elec-
tronics and embedded circuits. The goal is to provide
the scientific skills and the practical ability to analyse,
develop and deploy systems for the broad field of ro-
botics: low and high-level control systems, perception,
in particular robot vision, intelligence, motion and task
planning, communication, and human-robot interac-
tion. The courses are meant to provide an in-depth un-
derstanding of theory and the principles, methods, and
processes, allowing the graduates to achieve the com-
petences required in their future job responsibilities.
Typical activities include solving problems in the analy-
sis, design, development, integrating, deployment, de-
bugging, and maintenance of robotic and/or embedded
systems.

JOB PROSPECTS

The graduates of Embedded Robotics are prepared for cre-
ative engineering activities in the field of industrial and ser-
vice robotics, embedded electronics, and also for research
and scientific work including the PhD degree studies. Spe-
cifically, the graduates can pursue an industry, research and
development, business or administration career as:

» design engineer and/or programmer of embedded
systems and circuits,

» implementation/deployment specialist of industrial
robotic systems, robotics systems specialist,
integrator, project manager,

» control systems engineer, embedded control devices
and systems specialist, building and home automation
systems design engineer,

» expert/consultant for robotic systems deployment,
including intelligent and social robots.

ENTRY INFORMATION

Requirements: Bachelor's or Bachelor of En-
gineering Degree in Electrical Engineering
or related field. Minimum 210 ECTS.

Each application is assessed individually
on its merits. If in doubt, please contact
an Admission Officer, e-mail:

admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

» English:
Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List
of accepted language certificates can be
checked online.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time
» Language of instruction: English

» Start date:
February 2026

» Programme coordinator:
Elzbieta Roszkowska, PhD, DSc

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF ELECTRONICS, PHOTONICS AND MICROSYSTEMS
FIELD OF STUDY: | CONTROL ENGINEERING AND ROBOTICS |

EMBEDDED ROBOTICS |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER 1 SEMESTER 3

» Control Theory » Advanced Robot Control

» Embedded Systems » Social Robots

» Artificial Intelligence and Machine Learning » Task and Motion Planning

» Applied Logic » Master's Thesis Project

» Physics » Diploma Seminar

» Foreign language Al » Entrepreneurship

» Applications of Artificial Intelligence Models in » Social Communication
Automation

SEMESTER 2

» Control Theory for Embedded Systems
» Event-based Control

» Mobile Robotics

» Sensors and Actuators

» Modelling and Identification

» Theory and Methods of Optimization
» Intermediate Project

» Specialization Seminar

» Foreign Language B2

Master's Degree programme
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APPLIED MATHEMATICS

El DESCRIPTION

The programme, offered by the Faculty of Pure and
Applied Mathematics and run in cooperation with the
Hugo Steinhaus Center, is based on educational stand-
ards of the European Consortium for Mathematics
in Industry (ECMI) as confirmed by the status of ECMI
Teaching Centre obtained by Wroctaw University of Sci-
ence and Technology in 2014.

The curriculum is oriented towards real-life applica-
tions and industrial problems in educational style and
contents. The goal of the studies is the real world ap-
plied mathematics education of specialists who are
well prepared not only for work in the international
financial institutions or enterprises, but also for any
situation in which the creative thinking is needed. The
graduates have no problems with finding good jobs in
the finance and insurance or industrial sectors in Poland
and abroad. The MSc diploma offers an opportunity
to continue education at PhD studies.

The programme offers three main specialties:
» Financial and Actuarial Mathematics

» Industrial Mathematics

» Data-Driven Modelling

JOB PROSPECTS

ENTRY INFORMATION

Requirements: Bachelor's or Master's Degree
in Applied Mathematics, Control Engineer-
ing and Robotics, Economics, Electronics,
Electronics and Telecommunications, Com-
putational Physics, Technical Physics, Phys-
ics, Computer Science, Computer Science and
Econometrics, Industrial Computer Science,
Applied Computer Science, Data Engineering,
Quantum Engineering, Systems Engineering,
Mathematics, Mathematics and Statistics,
Mathematics in Technology, Computational
Mathematics, Teleinformatics, Telecommu-
nications and related domains obtained ei-
ther in Poland or abroad. Each application
is assessed individually on its merits. If in
doubt, please contact an Admission Officer,
e-mail: admission@pwr.edu.pl

Deadline for application
Tuition fee

Application fee

»  English: Equivalent of minimum TOEFL IBT
— 87 points or 6.5 points IELTS. List of
accepted language certificates can be
checked online.

The graduates will have obtained in-depth knowledge
in mathematics and economics/finance; experience
in pricing financial and actuarial contracts, modelling,
simulation and optimisation, computational methods,
data science and artificial intelligence.

They will be prepared for solving problems in the finan-
cial/actuarial and industrial sectors and gaining infor-
mation from the literature and other sources. They will
possess organizational skills and experience necessary
for a professional career in research units, industry and
at universities and colleges.

ABOUT STUDIES

» Duration: 3 semesters

»  Mode of study: Full time

» Language of instruction: English
» Start date: February 2026

» Programme coordinator:
Janusz Szwabinski, PhD, DSc

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
. phone: +48 71320 37 11, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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FACULTY OF PURE AND APPLIED MATHEMATICS

FIELD OF STUDY: | APPLIED MATHEMATICS |
MASTER'S DEGREE PROGRAMME

CONTENT

SEMESTER1

» Economathematics

» Partial Differential Equations with Applications
in Physics and Industry

» Computer Modelling and Simulation
of Stochastic Processes

» Elective Course

» Elective Course

» Social Science Elective Course

» Foreign Language

SEMESTER 2

» Optimization Theory

» Applied Functional Analysis
» Elective Course

» Elective Course

» Elective Course

» Humanities Elective Course
» Foreign language

SEMESTER 3

» Diploma Thesis
» Diploma Seminar
» Elective Course

ELECTIVE COURSES

» Financial Risk Management

» Computational Finance

» Non-life Insurance Mathematics

» Risk Management in Insurance

» Actuarial Mathematics for Life Contingent Risks

» Numerical Methods in Differential Equations

» Nonlinear Dynamics, Chaos and Fractals

» Introduction to Inverse Problems

» Operations Research

» Perturbation Methods

» Physics Informed Neural Networks for Forward
and Inverse Problems

» Data Processing with Rust

» Machine Learning for Data Analytics

» Analysis of Unstructured Data

» Estimation Theory

» Advanced Topics in Dynamic Games

» Large Language Models

» Reinforcement Learning in Multi-Agent Systems

» Biomathematics

» Stochastic Processes in Natural Sciences |

» Stochastic Processes in Natural Sciences Il

Master's Degree programme
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PREPARATORY

I
POLISH LANGUAGE COURSE L!—"@

DESCRIPTION

The Department of Polish Language for Foreigners
offers courses in Polish language and Polish culture on
different levels — A1, A2, B1, B2, C1. They are intended
for candidates who wish to prepare for future stud-
ies at all academies in Poland as well as for those who
want to learn Polish intensely. They include 20 lessons of
Polish language per week (5 times a week, 4 lessons a day).
The first term contains 300 hours of Polish language,
and so does the second term. The students also learn
supplementary subjects preparing them for their fur-
ther studies. The supplementary subjects can be se-
lected according to the students' needs out of the
following: mathematics, physics, computer sciences,
geography, knowledge of Polish culture and history. The
students start learning the specialisation courses on the
advanced level in the winter term and on the elemen-
tary level —in the summer term. The specialisation sub-
jects are taught in Polish.

The courses, thanks to the fact that they are carried
out on different levels, guarantee a communicative
dexterity in both official and unofficial situations.
At the same time, the courses prepare the candidates
for studying on different faculties. The students im-
prove basic linguistic competences: listening compre-
hension, reading comprehension, speaking and writing
different kinds of text. Additionally, some lectures and
classes on Polish history and culture are carried out
in Polish and English.

The course finishes with a written and oral exami-
nation in Polish language and with examinations in all
chosen subjects. The Department of Polish Language
for Foreigners provides also additional activities, such
as: tourist tours to the most interesting regions of Po-
land, visiting some historical places in Wroctaw and
participating in different cultural events. Taking part
in the course, the students learn about important tra-
ditions and customs of the Poles.

gl ENTRY INFORMATION

The university admission procedure based
on secondary education certificate or de-
gree certificate. Each application is assessed
individually on its merits. If in doubt, please
contact an Admission Officer, e-mail: admis-
sion@pwr.edu.pl

» Mode of study:
Full time, 600 hours

» Duration; start date:
1 academic year (2 semesters)
- October 2025

» Tuition fee*:
admission.pwr.edu.pl

» Deadline for application:
admission.pwr.edu.pl

» Language of instruction:
Polish

» Application fee:
e-mail: admission@pwr.edu.pl

» Contact:
e-mail: admission@pwr.edu.pl

* Fee also includes:

Textbooks, trips to the ZOO, water knowledge
centre ,Hydropolis”, the Four Domes Pavilion,
tours around Wroctaw and hiking trips and
much more.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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PREPARATORY

POLISH LANGUAGE COURSE

CONTENT

The curriculum of learning Polish as a foreign language on the elementary level A includes individual-connected
topics primarily (personal data, education, general look, family relations, leisure time activities, health, etc.). Subse-
quent subjects include: one's surroundings (both immediate: living place, students’ hostel, etc., and more distant:
city and its institutions), everyday routines, plants, animals, the weather and climate.

THE GRAMMATICAL MATERIAL
INCLUDES:

» declination of nouns, adjectives, pronouns and
numerals;

» verb inflexion, transitive and intransitive verbs,
voices and moods of verbs, impersonal forms
of verbs, modals and verbs connected with
movement;

» comparison of adjectives and adverbs;

» classifying words into different parts of speech;

» syntax of a single and compound sentence,
double negation, punctuation.

The curriculum includes also typical

communicative situations.

COURSES:

» Polish history has been presented from the
oldest to the contemporary times. The course
has been divided into parts determined by dates
of great significance to the society and the state.

» Introduction to computer science and basic
programming includes understanding syntax,
variables, and fundamental data types in Python.

» Participants of mathematics classes will have
an opportunity to get to know the language
and terminology used in mathematics. They
will also have a chance to make up for the
secondary school knowledge they miss (e.g.
digits, geometric figures, fractions, mathematical
actions, functions, sequences, etc.).

» The purpose of the physics course is giving
participants an opportunity to understand the
phenomena of the surrounding world and nature,
the structures of physics and its connections with
other natural sciences (kinematics, dynamics,
thermodynamics, electrostatics, optics,
contemporary physics, electric current).

Master's Degree programme
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PREPARATORY

ENGLISH LANGUAGE COURSE

El DESCRIPTION

The Department of Foreign Languages at Wroctaw Univer-
sity of Science and Technology offers preparatory courses
to foreigners who want to study BSc and MSc courses in
English at Wroctaw University of Science and Technology.
The course includes 600 hours of English (20 hours of Eng-
lish per week 5 times x 4 hours a day). The students can
also learn suplementary subjects preparing them for their
further studies as well as Polish language and culture.

To start the course of English students should be at inter-
mediate level B1 as set forth in Common European Frame-
work for Language, Teaching and Assessment. The aim of
the course is to help the students improve their language
skills and reach B2 level and to introduce English for aca-
demic purposes in order to enable them to follow the uni-
versity courses in English.

The preparatory English course lasts for the whole aca-
demic year (from October to June) and is divided into two
semesters. In the first semester the students learn general
English with professional language elements. The second
semester covers a balance of language skills (speaking, lis-
tening, reading, writing), grammar and vocabulary with a
special focus on academic language.

In addition to language training, students can select sup-
plementary subjects based on their academic needs.
These subjects include mathematics, physics, computer
science, and Polish language. Specialization subjects are
taught in English.

The course builds the skills required for understanding lec-
tures, tutorials, research papers and written assignments
in English. At the end of the course students take exami-
nations in English, selected supplementary subjects. The
English examination is at B2 level and consists of two parts,
a written test and an interview. The participants will be pro-
vided with coursebooks and other teaching materials to be
used at the preparatory English course all free of charge.
The final examination tests listening and reading skills,
speaking, writing, knowledge of grammar and vocabulary.
The exam registration fee is included in the price of the
course. Throughout the academic year the students will
be provided with an opportunity to go on 1-2 day trips to
discover the most beautiful places in the region.

The students will also be able to take part in talks and
lectures about history of Wroctaw and Poland, cultural
events, technical English and more.

ENTRY INFORMATION

The university admission procedure based on
secondary education certificate or degree cer-
tificate. Each application is assessed individually
on its merits. If in doubt, please contact an Ad-
mission Officer, e-mail: admission@pwr.edu.pl

» Mode of study:
Full time, 600 hours

» Duration; start date:
1 academic year (2 semesters)
- October 2025
or 1 semester - February 2026

» Deadline for application:
admission.pwr.edu.pl

» Tuition fee*:
admission.pwr.edu.pl

» Application fee:
admission.pwr.edu.pl

» Contact:
e-mail: admission@pwr.edu.pl

* Fee also includes:

Textbooks, trips to the ZOO, water
knowledge centre ,Hydropolis” and the
Four Domes Pavilion, tours around Wroctaw,
hiking trips and much more.

Questions? Please contact the Admission Officers e-mail: admission@pwr.edu.pl,
e  phone: +48 713203711, +48 71320 3170, +48 71320 44 39

Wroctaw University of Science and Technology
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PREPARATORY

ENGLISH LANGUAGE COURSE

CONTENT

ENGLISH COURSE SYLLABUS 1" TERM
SPEAKING

» communicating in social situations

» communicating in professional and intercultural
environment

» telephoning: making enquiries, making arrange-
ments, complaining

» focusing on functions: agreeing and disagreeing,
giving opinions, interrupting and dealing with
interruptions, asking for clarification

» discussing a wide range of personal and study/work-
-related topics: culture and cross-cultural relations,
university and business-related environment, training
and development, describing innovative products and
services, business travel, buying and selling

» focusing on pronunciation: word and sentence
stress, sound linking

LISTENING

» understanding real life situations

» following instructions

» listening for general meaning, details, pronunciation,
stress and intonation reading

» understanding written instructions

» understanding story sequence

» understanding authentic writing

WRITING

» organising writing

» using a range of styles

» writing formal and informal letters and emails
» writing CVs and letters of application

GRAMMAR

» revision of tenses

» conditionals

» question forms

» comparatives

» dependent prepositions
» relative clauses

» indirect speech

VOCABULARY

» building a personal lexicon based on topical vocabulary
» business vocabulary
» formal and informal vocabulary

ENGLISH COURSE SYLLABUS 2" TERM
ACADEMIC SPEAKING

» communicating in seminars and tutorials

» delivering an oral presentation

» focusing on functions: expressing and justifying
opinions, explaining, suggesting, speculating,
analysing, summarising, narrating

» recognising a range of styles

» speaking without hesitating

ACADEMIC LISTENING

» understanding lectures and tutorials
» following presentations
» note taking

ACADEMIC READING

» understanding specialist and non-specialist
academic writing

» identifying text types

» scanning and skimming

ACADEMIC WRITING

» organising writing

» expressing fact and opinion

» describing and comparing graphs and tables
» describing processes

» writing a report

» writing a summary

» writing an argumentative essay
» using quotations

» paraphrasing

» recognising levels of formality

GRAMMAR FOR ACADEMIC PURPOSES

» understanding choice of tense

» impersonal style and passive constructions
» modal verbs

» forming complex noun phrases

» changing emphasis in a sentence

» expressing causality and purpose

VOCABULARY FOR ACADEMIC
PURPOSES

» language for classifying

» word formation

» confusable words

» technical and semi-technical vocabulary
» researching specialist vocabulary

Master's Degree programme
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® Wroctaw University of Science and Technology
@ Admissions Center ® Foreign Student Admissions Office
® www.pwr.edu.pl ® www.admission.pwr.edu.pl ® e-mail: admission@pwr.edu.pl
telephone: +48 71 320 37 11, +48 71 320 31 70, +48 71 320 44 39
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